E8a Emulator

User's Manual

Supported Devices:
  R8C Family
  M16C Family
  H8S Family
  H8 Family
  740 Family

All information contained in these materials, including products and product specifications, represents information on the product at the time of publication and is subject to change by Renesas Electronics Corporation without notice. Please review the latest information published by Renesas Electronics Corporation through various means, including the Renesas Electronics Corporation website (http://www.renesas.com).
Notice

1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products and application examples. You are fully responsible for the incorporation of these circuits, software, and information in the design of your equipment. Renesas Electronics assumes no responsibility for any losses incurred by you or third parties arising from the use of these circuits, software, or information.

2. Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas Electronics does not warrant that such information is error free. Renesas Electronics assumes no liability whatsoever for any damages incurred by you resulting from errors in or omissions from the information included herein.

3. Renesas Electronics does not assume any liability for infringement of patents, copyrights, or other intellectual property rights of third parties by or arising from the use of Renesas Electronics products or technical information described in this document. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics or others.

4. You should not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or in part. Renesas Electronics assumes no responsibility for any losses incurred by you or third parties arising from such alteration, modification, copy or otherwise misappropriation of Renesas Electronics product.

5. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The recommended applications for each Renesas Electronics product depends on the product’s quality grade, as indicated below.

“Standard”: Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home electronic appliances; machine tools; personal electronic equipment; and industrial robots etc.

“High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster systems; anti-crime systems; and safety equipment etc.

Renesas Electronics products are neither intended nor authorized for use in products or systems that may pose a direct threat to human life or bodily injury (artificial life support devices or systems, surgical implants etc.), or may cause serious property damages (nuclear reactor control systems, military equipment etc.). You must check the quality grade of each Renesas Electronics product before using it in a particular application. You may not use any Renesas Electronics product for any application for which it is not intended. Renesas Electronics shall not be in any way liable for any damages or losses incurred by you or third parties arising from the use of any Renesas Electronics product for which the product is not intended by Renesas Electronics.

6. You should use the Renesas Electronics products described in this document within the range specified by Renesas Electronics, especially with respect to the maximum rating, operating supply voltage range, movement power voltage range, heat radiation characteristics, installation and other product characteristics. Renesas Electronics shall have no liability for malfunctions or damages arising out of the use of Renesas Electronics products beyond such specified ranges.

7. Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products have specific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Further, Renesas Electronics products are not subject to radiation resistance design. Please be sure to implement safety measures to guard them against the possibility of physical injury, and injury or damage caused by fire in the event of the failure of a Renesas Electronics product, such as safety design for hardware and software including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult, please evaluate the safety of the final products or systems manufactured by you.

8. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas Electronics product. Please use Renesas Electronics products in compliance with all applicable laws and regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS Directive. Renesas Electronics assumes no liability for damages or losses occurring as a result of your noncompliance with applicable laws and regulations.

9. Renesas Electronics products and technology may not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited under any applicable domestic or foreign laws or regulations. You should not use Renesas Electronics products or technology described in this document for any purpose relating to military applications or use by the military, including but not limited to the development of weapons of mass destruction. When exporting the Renesas Electronics products or technology described in this document, you should comply with the applicable export control laws and regulations and follow the procedures required by such laws and regulations.

10. It is the responsibility of the buyer or distributor of Renesas Electronics products, who distributes, disposes of, or otherwise places the product with a third party, to notify such third party in advance of the contents and conditions set forth in this document, Renesas Electronics assumes no responsibility for any losses incurred by you or third parties as a result of unauthorized use of Renesas Electronics products.

11. This document may not be reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.

12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas Electronics products, or if you have any other inquiries.

(Note 1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its majority-owned subsidiaries.

(Note 2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.
Introduction

This manual describes the followings:

- E8a Emulator functions
- Preparation before use
- Debugger functions
- Tutorial
- Appendix: (Components of the E8a Emulator, Notes on High-performance Embedded Workshop, and Diagnostic Test Procedure)

This manual does not intend to explain how to write C/C++ or assembly language programs, how to use any particular operating system or how best to tailor code for the individual devices. These issues are left to the respective manuals.

Microsoft®, Windows® and Windows Vista® are registered trademarks of Microsoft Corporation.
IBM is a registered trademark of International Business Machines Corporation.
All brand or product names used in this manual are trademarks or registered trademarks of their respective companies or organizations.

Document Conventions

This manual uses the following typographic conventions:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Menu-&gt;Menu Option]</td>
<td>Bold text with '&gt;' is used to indicate menu options (for example, [File-&gt;Save As...]).</td>
</tr>
<tr>
<td>FILENAME.C</td>
<td>Uppercase names are used to indicate filenames.</td>
</tr>
<tr>
<td>&quot;enter this string&quot;</td>
<td>Used to indicate text that must be entered (excluding the &quot;&quot; quotes).</td>
</tr>
<tr>
<td>Key + Key</td>
<td>Used to indicate required key presses. For example, CTRL+N means press the CTRL key and then, whilst holding the CTRL key down, press the N key.</td>
</tr>
<tr>
<td>(The &quot;how to&quot; symbol)</td>
<td>When this symbol is used, it is always located in the left hand margin. It indicates that the text to its immediate right is describing &quot;how to&quot; do something.</td>
</tr>
</tbody>
</table>
IMPORTANT

Before using this product, be sure to read the user’s manual (this user’s manual) carefully. Keep this user’s manual, and refer to this when you have questions about this product.

**Emulator:**
The emulator in this document refers to the following products that are manufactured by Renesas Electronics Corporation:

1. Emulator
2. User system interface cable

The emulator herein does not include the customer’s user system and host machine.

**Purpose of use of this product:**
This emulator is a device to support the development of a system that uses the Renesas MCUs. It provides support for system development in both software and hardware.

Be sure to use this emulator correctly according to said purpose of use. Please avoid using this emulator for other than its intended purpose of use.

**For those who use this product:**
This emulator can only be used by those who have carefully read the user’s manual and know how to use it.

Use of this emulator requires the basic knowledge of electric circuits, logical circuits, and MCUs.

**When using this product:**

1. This product is a development-support unit for use in your program development and evaluation stages. When a program you have finished developing is to be incorporated in a mass-produced product, the judgment as to whether it can be put to practical use is entirely your own responsibility, and should be based on evaluation of the device on which it is installed and other experiments.

2. In no event shall Renesas Electronics Corporation be liable for any consequence arising from the use of this product.

3. Renesas Electronics Corporation strives to provide workarounds for and correct trouble with products malfunctions, with some free and some incurring charges. However, this does not necessarily mean that Renesas Electronics Corporation guarantees the provision of a workaround or correction under any circumstances.

4. This product covered by this document has been developed on the assumption that it will be used for program development and evaluation in laboratories. Therefore, it does not fall within the scope of applicability of the Electrical Appliance and Material Safety Law and protection against electromagnetic interference when used in Japan.

5. Renesas Electronics Corporation cannot predict all possible situations and possible cases of misuse that carry a potential for danger. Therefore, the warnings in this user's manual and the warning labels attached to this product do not necessarily cover all such possible situations and cases. The customer is responsible for correctly and safely using this product.

6. The product covered by this document has not been through the process of checking conformance with UL or other safety standards and IEC or other industry standards. This fact must be taken into account when the product is taken from Japan to some other country.

7. Renesas Electronics Corporation will not assume responsibility of direct or indirect damage caused by an accidental failure or malfunction in this product.

**When disposing of this product:**
Penalties may be applicable for incorrect disposal of this waste, in accordance with your national legislation.

**Usage restrictions:**
This emulator has been developed as a means of supporting system development by users. Therefore, do not use it as a device used for equipment-embedded applications. Also, do not use it for developing the systems or equipment used for the following purposes either:

1. Transportation and vehicular
2. Medical (equipment where human life is concerned)
3. Aerospace
4. Nuclear power control
5. Undersea repeater

If you are considering the use of this emulator for one of the above purposes, please be sure to consult your local distributor.

**About product changes:**
We are constantly making efforts to improve the design and performance of this emulator. Therefore, the specification or design of this emulator or its user’s manual may be changed without prior notice.
About the rights:
We assume no responsibility for any damage or infringement on patent rights or any other rights arising from the use of any information, products or circuits presented in this user’s manual.
(1) We assume no responsibility for any damage or infringement on patent rights or any other rights arising from the use of any information, products or circuits presented in this user’s manual.
(2) The information or data in this user’s manual does not implicitly or otherwise grant a license for patent rights or any other rights belonging to us or third parties.
(3) This user’s manual and this emulator are copyrighted, with all rights reserved by us. This user’s manual may not be copied, duplicated or reproduced, in whole or part, without prior written consent of us.

About diagrams:
The diagrams in this user’s manual may not all represent exactly the actual object.

Device names:
Sections 1 through 6 in this user’s manual use R8C Family as an example of the device names.

Guarantee:
If your product becomes faulty within one year after its purchase while being used under good conditions by observing "IMPORTANT" and "Precautions for Safety" described in this user's manual, we will repair or replace your faulty product free of charge. Note, however, that if your product's fault is raised by any one of the following causes, we will repair it or replace it with new one with extra-charge:
- Misuse, abuse, or use under extraordinary conditions
- Unauthorized repair, remodeling, maintenance, and so on
- Inadequate user's system or misuse of it
- Fires, earthquakes, and other unexpected disasters
In the above cases, contact your local distributor.
Precautions for Safety

This chapter describes the precautions which should be taken in order to use this product safely and properly. Be sure to read and understand this chapter before using this product. Contact us if you have any questions about the precautions described here.

⚠️ WARNING  
WARNING indicates a potentially dangerous situation that will cause death or heavy wound unless it is avoided.

⚠️ CAUTION  
CAUTION indicates a potentially dangerous situation that will cause a slight injury or a medium-degree injury or property damage unless it is avoided.

In addition to the two above, the following are also used as appropriate.

⚠️ means WARNING or CAUTION.  
Example: ⚠️ CAUTION AGAINST AN ELECTRIC SHOCK

🚫 means PROHIBITION.  
Example: ⚠️ DISASSEMBLY PROHIBITED

⚠️ means A FORCIBLE ACTION.  
Example: ⚠️ UNPLUG THE POWER CABLE FROM THE RECEPTACLE.
## WARNING

**Warnings for Power Supply:**
If you smell a strange odor, hear an unusual sound, or see smoke coming from this product, then disconnect power immediately by unplugging the AC power cable from the outlet. Do not use this as it is because of the danger of electric shock and/or fire. In this case, contact your local distributor.

Before setting up this product and connecting it to other devices, turn off power or remove a power cable to prevent injury or product damage.

Always switch off the host computer and user system before connecting or disconnecting any cables or parts. Failure to do so will result in a fire hazard and will damage the user system and the emulator product. The user program will be lost.

**Warnings to Be Taken for Handling:**
Do not modify this product. Personal injury due to electric shock may occur if this product is modified. Modifying the product will void your warranty. For repairing this product, contact your local distributor.

**Warning for Installation:**
Do not set this product in water or areas of high humidity. Make sure that the product does not get wet. Spilling water or some other liquid into the product may cause un-repairable damage.

**Warning for Use temperature:**
This equipment is to be used in an environment with a maximum ambient temperature of 35°C. Care should be taken that this temperature is not exceeded.

**Warning for Connecting Cables:**
Connect the connectors in the user system and in the user interface cable by confirming the correct direction. Failure to do so will result in a fire hazard and will damage the user system and the emulator product.
### Precautions for Safety

<table>
<thead>
<tr>
<th><strong>CAUTION</strong></th>
</tr>
</thead>
</table>

#### Cautions to Be Taken for Turning On the Power:

- **Warning:** Turn ON/OFF the power of the emulator and the user system as simultaneously as possible. If you cannot turn on the powers simultaneously, turn on the emulator first and then the user system.
- When turning on the power again after shutting off the power, wait about 10 seconds.

#### Cautions to Be Taken for Handling This Product:

- Use caution when handling the product. Be careful not to apply a mechanical shock.
- Do not touch the connector pins of the emulator and the target MCU connector pins directly. Static electricity may damage the internal circuits.
- When attaching and removing the cable, hold the plug of the cable and do not touch the cable. Do not pull the emulator by the communications interface cable or the flexible cable. And, excessive flexing or force may break conductors.
- Do not flex the flexible cable excessively. The cable may cause a break.
- Place the host computer and user system so that no cable is bent or twisted. A bent or twisted cable will impose stress on the user interface leading to connection or contact failure. Make sure that the host computer and the user system are placed in a secure position so that they do not move during use nor impose stress on the user interface.

#### Note on Transporting the Product:

- When sending your product for repair, use the packing box and cushioning material supplied with the product when it was delivered to you and specify caution in handling (handling as precision equipment). If packing of your product is not complete, it may be damaged during transportation.
- When you pack your product in a bag, make sure to use the conductive plastic bag supplied with the product (usually a blue bag). If you use a different bag, it may lead to further trouble with your product due to static electricity.

#### Caution to Be Taken for System Malfunctions:

- If the emulator malfunctions because of interference like external noise, do the following to remedy the trouble.
  1. Exit the emulator debugger, and shut OFF the emulator and the user system.
  2. After a lapse of 10 seconds, turn ON the power of the emulator and the user system again, then launch the emulator debugger.

#### Caution to Be Taken for Disposal:

- Penalties may be applicable for incorrect disposal of this waste, in accordance with your national legislation.

#### European Union regulatory notices:

- The WEEE (Waste Electrical and Electronic Equipment) regulations put responsibilities on producers for the collection and recycling or disposal of electrical and electronic waste. Return of WEEE under these regulations is applicable in the European Union only. This equipment (including all accessories) is not intended for household use. After use the equipment cannot be disposed of as household waste, and the WEEE must be treated, recycled and disposed of in an environmentally sound manner.

  Renesas Electronics Europe GmbH can take back end of life equipment, register for this service at “http://www.renesas.eu/weee”. 
Contents

Introduction .................................................................................................................. 3

IMPORTANT .............................................................................................................. 4

Precautions for Safety ............................................................................................... 6

Contents ......................................................................................................................... 9

1. Overview ................................................................................................................. 12
   1.1 Warnings ............................................................................................................. 14
   1.2 Environmental Conditions ............................................................................... 15
   1.3 Components ......................................................................................................... 16

2. E8a Emulator Functions ......................................................................................... 17
   2.1 Overview ............................................................................................................. 17
   2.2 Trace Functions .................................................................................................. 18
   2.3 Break Functions ................................................................................................. 18
   2.4 Memory Access Functions ................................................................................. 18
   2.5 Stack Trace Function ......................................................................................... 20
   2.6 Start/Stop Function ........................................................................................... 20
   2.7 Online Help ........................................................................................................ 20
   2.8 Regulatory Compliance Notices ......................................................................... 21

3. Preparation before Use ......................................................................................... 22
   3.1 Emulator Preparation ......................................................................................... 22
   3.2 Emulator Hardware Configuration ................................................................... 23
   3.3 Emulator Software Configuration .................................................................... 29
      3.3.1 CD .............................................................................................................. 29
   3.4 Installing Emulator's Debugger ....................................................................... 29
   3.5 Connecting the Emulator to the Host Computer .............................................. 30
   3.6 Connecting the Emulator to the User System ................................................... 31
   3.7 Connecting System Ground .............................................................................. 32
   3.8 System Check ..................................................................................................... 33

4. Preparations for Debugging .................................................................................... 41
   4.1 Method for Activating High-performance Embedded Workshop ...................... 41
      4.1.1 Creating the New Workspace (Toolchain Not Used) .................................... 42
      4.1.2 Creating the New Workspace (Toolchain Used) .......................................... 46
      4.1.3 Selecting an Existing Workspace .................................................................. 52
   4.2 Setting at E8a Emulator Activation ................................................................ 53
      4.2.1 Setting at Emulator Activation ................................................................... 53
      4.2.2 Downloading a Program .............................................................................. 55
      4.2.3 Setting the [Program Flash] Mode ................................................................. 56

5. Debugging ............................................................................................................... 62
   5.1 Setting the Environment for Emulation ............................................................. 62
      5.1.1 Opening the [Configuration] Dialog Box ...................................................... 62
      5.1.2 [General] Page ............................................................................................. 62
   5.2 Downloading a Program .................................................................................... 64
      5.2.1 Downloading a Program .............................................................................. 64
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.2.2</td>
<td>Viewing the Source Code</td>
<td>64</td>
</tr>
<tr>
<td>5.3</td>
<td>Stopping Your Program</td>
<td>67</td>
</tr>
<tr>
<td>5.3.1</td>
<td>Address Match Breakpoints</td>
<td>67</td>
</tr>
<tr>
<td>5.4</td>
<td>Using the Event Points</td>
<td>68</td>
</tr>
<tr>
<td>5.4.1</td>
<td>PC Breakpoints</td>
<td>68</td>
</tr>
<tr>
<td>5.4.2</td>
<td>Break Conditions</td>
<td>68</td>
</tr>
<tr>
<td>5.4.3</td>
<td>Opening the [Event] Window</td>
<td>68</td>
</tr>
<tr>
<td>5.4.4</td>
<td>Setting PC Breakpoints</td>
<td>69</td>
</tr>
<tr>
<td>5.4.5</td>
<td>Add</td>
<td>69</td>
</tr>
<tr>
<td>5.4.6</td>
<td>Edit</td>
<td>69</td>
</tr>
<tr>
<td>5.4.7</td>
<td>Enable</td>
<td>69</td>
</tr>
<tr>
<td>5.4.8</td>
<td>Disable</td>
<td>69</td>
</tr>
<tr>
<td>5.4.9</td>
<td>Delete</td>
<td>69</td>
</tr>
<tr>
<td>5.4.10</td>
<td>Delete All</td>
<td>70</td>
</tr>
<tr>
<td>5.4.11</td>
<td>Go to Source</td>
<td>70</td>
</tr>
<tr>
<td>5.4.12</td>
<td>[Set Break] Dialog Box</td>
<td>71</td>
</tr>
<tr>
<td>5.4.13</td>
<td>Setting Break Conditions</td>
<td>72</td>
</tr>
<tr>
<td>5.4.14</td>
<td>Edit</td>
<td>73</td>
</tr>
<tr>
<td>5.4.15</td>
<td>Enable</td>
<td>73</td>
</tr>
<tr>
<td>5.4.16</td>
<td>Disable</td>
<td>73</td>
</tr>
<tr>
<td>5.4.17</td>
<td>Delete</td>
<td>73</td>
</tr>
<tr>
<td>5.4.18</td>
<td>Delete All</td>
<td>73</td>
</tr>
<tr>
<td>5.4.19</td>
<td>Go to Source</td>
<td>73</td>
</tr>
<tr>
<td>5.4.20</td>
<td>Sequential Conditions</td>
<td>73</td>
</tr>
<tr>
<td>5.4.21</td>
<td>Editing Break Conditions</td>
<td>73</td>
</tr>
<tr>
<td>5.4.22</td>
<td>Modifying Break Conditions</td>
<td>73</td>
</tr>
<tr>
<td>5.4.23</td>
<td>Enabling Break Conditions</td>
<td>73</td>
</tr>
<tr>
<td>5.4.24</td>
<td>Disabling Break Conditions</td>
<td>73</td>
</tr>
<tr>
<td>5.4.25</td>
<td>Deleting Break Conditions</td>
<td>74</td>
</tr>
<tr>
<td>5.4.26</td>
<td>Deleting All Break Conditions</td>
<td>74</td>
</tr>
<tr>
<td>5.4.27</td>
<td>Viewing the Source Line for Break Conditions</td>
<td>74</td>
</tr>
<tr>
<td>5.4.28</td>
<td>[Break condition x] Dialog Box</td>
<td>74</td>
</tr>
<tr>
<td>5.5</td>
<td>Viewing the Trace Information</td>
<td>76</td>
</tr>
<tr>
<td>5.5.1</td>
<td>Opening the [Trace] Window</td>
<td>76</td>
</tr>
<tr>
<td>5.5.2</td>
<td>Acquiring Trace Information</td>
<td>76</td>
</tr>
<tr>
<td>5.5.3</td>
<td>Clearing the Trace Information</td>
<td>76</td>
</tr>
<tr>
<td>5.5.4</td>
<td>Saving the Trace Information in a File</td>
<td>76</td>
</tr>
<tr>
<td>5.5.5</td>
<td>Viewing the [Source] Window</td>
<td>77</td>
</tr>
<tr>
<td>5.5.6</td>
<td>Trimming the Source</td>
<td>77</td>
</tr>
<tr>
<td>5.6</td>
<td>Using the Start/Stop Function</td>
<td>78</td>
</tr>
<tr>
<td>5.6.1</td>
<td>Opening the [Start/Stop Function Setting] Dialog Box</td>
<td>78</td>
</tr>
<tr>
<td>5.6.2</td>
<td>Specifying the Routine to be Executed</td>
<td>78</td>
</tr>
<tr>
<td>5.6.3</td>
<td>Restrictions on the Start/Stop Function</td>
<td>79</td>
</tr>
<tr>
<td>6.</td>
<td>Tutorial</td>
<td>80</td>
</tr>
<tr>
<td>6.1</td>
<td>Introduction</td>
<td>80</td>
</tr>
<tr>
<td>6.2</td>
<td>Running the High-performance Embedded Workshop</td>
<td>80</td>
</tr>
<tr>
<td>6.3</td>
<td>Setting up the E8a Emulator</td>
<td>80</td>
</tr>
<tr>
<td>6.4</td>
<td>Setting the [Configuration] Dialog Box</td>
<td>81</td>
</tr>
<tr>
<td>6.5</td>
<td>Checking the Operation of RAM</td>
<td>82</td>
</tr>
<tr>
<td>6.6</td>
<td>Downloading the Tutorial Program</td>
<td>83</td>
</tr>
<tr>
<td>6.6.1</td>
<td>Downloading the Tutorial Program</td>
<td>83</td>
</tr>
<tr>
<td>6.6.2</td>
<td>Displaying the Source Program</td>
<td>84</td>
</tr>
</tbody>
</table>
6.7 Setting a PC Breakpoint ................................................................. 85
6.8 Setting Registers ........................................................................ 86
6.9 Executing the Program ................................................................. 87
6.10 Reviewing Breakpoints ............................................................... 89
6.11 Viewing Memory ........................................................................ 90
6.12 Watching Variables .................................................................... 91
6.13 Stepping Through a Program ..................................................... 93
  6.13.1 Executing [Step In] Command .................................................. 93
  6.13.2 Executing [Step Out] Command ............................................. 94
  6.13.3 Executing [Step Over] Command ........................................... 95
6.14 Forced Breaking of Program Executions ...................................... 96
6.15 Displaying Local Variables .......................................................... 96
6.16 Break Function ........................................................................... 97
  6.16.1 PC Break Function .................................................................. 97
6.17 Hardware Break Function .......................................................... 100
6.18 Trace Functions .......................................................................... 103
  6.18.1 Displaying the Trace Window .................................................. 103
6.19 Stack Trace Function ................................................................... 104
6.20 What Next? ................................................................................. 105

7. Appendix A: Components of the E8a Emulator .................................. 106

8. Appendix B: Window Functions ....................................................... 107

9. Appendix C: Command-Line Functions .......................................... 110

10. Appendix D: Notes on High-performance Embedded Workshop .......... 111

11. Appendix E: E8aSCP (E8a Self-Check Program) .............................. 115
  11.1 Flowchart of the Procedure to Execute the Self-Check Program ........ 115
  11.2 System Setup to Execute the E8aSCP .......................................... 116
  11.3 Executing the Self-Check Program .............................................. 118

Revision History ................................................................................ 122
1. Overview

The High-performance Embedded Workshop is a Graphical User Interface intended to facilitate the development and debugging of applications written in C/C++ programming language and assembly language for Renesas microcomputers. Its aim is to provide a powerful yet intuitive way of accessing, observing and modifying the debugging platform in which the application is running.

The E8a emulator (hereafter referred to as the emulator) is a software and hardware development support tool for application systems using the Renesas microcomputer. For applicable MCUs, refer to our web site.

The main unit of the emulator is connected through the dedicated debugging interface to the user system. The user system can be debugged under the conditions similar to the actual application conditions. The emulator enables debugging anywhere indoors or out. The host computer for controlling the emulator must be an IBM PC compatible machine with USB.

This manual describes the contents that comply with versions of the High-performance Embedded Workshop 4.0 or later.

![Figure 1.1 System Configuration with the Emulator](image-url)
The emulator has three activation modes:

(1) Erase Flash and Connect
This mode is used to erase data of the MCU flash memory and activate the debugger. A program for the emulator is also written to at the same time.

(2) Keep Flash and Connect
This mode is used to activate the debugger while retaining data of the MCU flash memory. However, areas for the emulator program and vector areas used by the emulator will be changed.

(3) Program Flash
This mode is used to activate the emulator as a simplified programmer. During the download, the data is written only to the user program and not to the E8a emulator program. Accordingly, in this mode, program debugging is not available.

The emulator provides the following features:

(1) Programming for Renesas’ 8- to 32-bit microcomputers
The emulator functions as a flash memory programming tool for Renesas’ 8- to 32-bit MCUs.

(2) Operation at low voltage
The minimum operating voltage has been reduced to 1.8 V. Thus, it supports MCUs that require low-voltage programming for their flash memory. (The voltage used for flash memory programming must be compliant with the MCU specifications.)

(3) Highly cost-effective card emulator
Achieves size reduction and USB connection.

(4) Realtime emulation
Realtime emulation can be conducted at the maximum operating frequency of the MCU.

(5) Excellent operability
Pointing devices such as mouse can be used during the debugging of the user program by running High-performance Embedded Workshop on Windows® XP (32-bit edition), Windows Vista® (32-bit edition) or Windows® 7 (32-bit or 64-bit edition).

(6) Comprehensive debugging functions
Various break and trace functions are provided for improved debugging efficiency. You can set break points and break conditions using dedicated windows while displaying trace information in a window. Various command-line functions are also provided.

(7) Debugging of the user system in the final development stage
The user system can be debugged under conditions similar to the actual application conditions.

(8) Compact debugging environment
A laptop computer can be used as a host computer, creating a debugging environment in any place.
1.1 Warnings

⚠️ CAUTION

Caution to be taken when using this product:

Read the following warnings before using the emulator product. Incorrect operation will damage the user system and the emulator product. The user program will be lost.

(1) Check all components against the component list provided at the rear side of the component box after unpacking the emulator.

(2) Never place heavy objects on the casing.

(3) Protect the emulator from excessive impacts and stresses. For details, refer to section 1.2, Environmental Conditions.

(4) When moving the host computer or user system, take care not to vibrate or damage it.

(5) After connecting the cable, check that it is connected correctly. For details, refer to section 3, Preparation before Use.

(6) Supply power to the connected equipment after connecting all cables. Cables must not be connected or removed while the power is on.
1.2 Environmental Conditions

**CAUTION**

**Caution to be taken when using this product:**

Observe the conditions listed in Tables 1.1 to 1.3 when using the emulator. Failure to do so may result in improper operation of the user system, the emulator product, and the user program.

**Table 1.1 Environmental Conditions**

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temperature</td>
<td>Operating: +10°C to +35°C</td>
</tr>
<tr>
<td></td>
<td>Storage: −10°C to +50°C</td>
</tr>
<tr>
<td>Humidity</td>
<td>Operating: 35% RH to 80% RH, no condensation</td>
</tr>
<tr>
<td></td>
<td>Storage: 35% RH to 80% RH, no condensation</td>
</tr>
<tr>
<td>Vibration</td>
<td>Operating: 2.45 m/s² max.</td>
</tr>
<tr>
<td></td>
<td>Storage: 4.9 m/s² max.</td>
</tr>
<tr>
<td></td>
<td>Transportation: 14.7 m/s² max.</td>
</tr>
<tr>
<td>Ambient gases</td>
<td>No corrosive gases may be present</td>
</tr>
</tbody>
</table>

**Table 1.2 Operating Environments (Windows® XP)**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host computer</td>
<td>IBM PC or compatible</td>
</tr>
<tr>
<td>OS</td>
<td>Windows® XP 32-bit edition (64-bit edition not supported)</td>
</tr>
<tr>
<td>CPU</td>
<td>Pentium 4 running at 1.6 GHz or more recommended</td>
</tr>
<tr>
<td>Host machine interface</td>
<td>USB (USB1.1, full-speed), also USB 2.0 interface supported</td>
</tr>
<tr>
<td></td>
<td>Operation with all combinations of host machine, USB device and USB hub is not guaranteed for the USB interface.</td>
</tr>
<tr>
<td>Memory</td>
<td>1 Gbyte plus 10 times the file size of the load module or larger recommended.</td>
</tr>
<tr>
<td>Pointing device such as mouse</td>
<td>Mouse or any other pointing device usable with the above OS that can be connected to the host machine.</td>
</tr>
<tr>
<td>CD drive</td>
<td>Needed to install the emulator debugger or refer to the user's manual.</td>
</tr>
<tr>
<td>Hard-disk</td>
<td>Emulator debugger installation needs 600 MB or more free space. (In view of swap area, keep another free space which is more than twice the memory capacity. (More than four times the memory capacity recommended.))</td>
</tr>
<tr>
<td>Display resolution</td>
<td>1024 × 768 or greater recommended.</td>
</tr>
</tbody>
</table>
## Table 1.3 Operating Environments (Windows Vista® and Windows® 7)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host computer</td>
<td>IBM PC or compatible</td>
</tr>
<tr>
<td>OS</td>
<td>Windows® 7 32/64-bit editions</td>
</tr>
<tr>
<td></td>
<td>Windows Vista® 32-bit edition (64-bit edition not supported)</td>
</tr>
<tr>
<td>CPU</td>
<td>Pentium 4 running at 3 GHz or Core 2 Duo running at 1 GHz or more recommended.</td>
</tr>
<tr>
<td>Host machine interface</td>
<td>USB (USB1.1, full-speed), also USB 2.0 interface supported</td>
</tr>
<tr>
<td></td>
<td>Operation with all combinations of host machine, USB device and USB hub is not guaranteed for the USB interface.</td>
</tr>
<tr>
<td>Memory</td>
<td>2 Gbytes plus 10 times the file size of the load module or larger recommended (32-bit edition).</td>
</tr>
<tr>
<td></td>
<td>3 Gbytes plus 10 times the file size of the load module or larger recommended (64-bit edition).</td>
</tr>
<tr>
<td>Pointing device such as mouse</td>
<td>Mouse or any other pointing device usable with the above OS that can be connected to the host machine.</td>
</tr>
<tr>
<td>CD drive</td>
<td>Needed to install the emulator debugger or refer to the user's manual.</td>
</tr>
<tr>
<td>Hard-disk</td>
<td>Emulator debugger installation needs 600 MB or more free space. (In view of swap area, keep another free space which is more than twice the memory capacity. (More than four times the memory capacity recommended.))</td>
</tr>
<tr>
<td>Display resolution</td>
<td>1024 × 768 or greater recommended.</td>
</tr>
</tbody>
</table>

### 1.3 Components

Check that all of the components are present when unpacking the product. For details on the E8a emulator components, refer to the component list provided at the rear side of the component box. If all of the components are not present, contact your nearest Renesas sales office.
2. E8a Emulator Functions

This section describes the emulator functions. They differ according to the device supported by the emulator.

2.1 Overview

Table 2.1 gives a functional overview of the emulator.

Table 2.1 Emulator Functions

<table>
<thead>
<tr>
<th>Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>User program execution function</td>
<td>• Executes a program at an operating frequency guaranteed for the applicable device.</td>
</tr>
<tr>
<td></td>
<td>• Reset emulation</td>
</tr>
<tr>
<td></td>
<td>• Step functions:</td>
</tr>
<tr>
<td></td>
<td>Single step (one step: one instruction)</td>
</tr>
<tr>
<td></td>
<td>Source-level step (one step: one source)</td>
</tr>
<tr>
<td></td>
<td>Step over (Break is not set inside a subroutine.)</td>
</tr>
<tr>
<td></td>
<td>Step out (Executes a function inside the subroutine pointed by PC until it is returned to the calling function.)</td>
</tr>
<tr>
<td>Reset function</td>
<td>• Issues a reset from the High-performance Embedded Workshop to the device during break.</td>
</tr>
<tr>
<td>Trace function</td>
<td>• Branch trace function incorporated in the device (four branches)</td>
</tr>
<tr>
<td></td>
<td>The support of this function depends on a device.</td>
</tr>
<tr>
<td>Break functions</td>
<td>• Hardware break condition (one condition)</td>
</tr>
<tr>
<td></td>
<td>The support of this function depends on a device.</td>
</tr>
<tr>
<td></td>
<td>• PC break condition (255 points)</td>
</tr>
<tr>
<td></td>
<td>• Forced break function</td>
</tr>
<tr>
<td></td>
<td>• Address match break function</td>
</tr>
<tr>
<td>Memory access function</td>
<td>• Downloading to RAM</td>
</tr>
<tr>
<td></td>
<td>• Downloading to flash memory</td>
</tr>
<tr>
<td></td>
<td>• Single-line assembly</td>
</tr>
<tr>
<td></td>
<td>• Reverse assembly (disassembly)</td>
</tr>
<tr>
<td></td>
<td>• Reading of memory</td>
</tr>
<tr>
<td></td>
<td>• Writing to memory</td>
</tr>
<tr>
<td></td>
<td>• Automatic updating of a display of selected variables during user program execution</td>
</tr>
<tr>
<td></td>
<td>• FILL</td>
</tr>
<tr>
<td></td>
<td>• Search</td>
</tr>
<tr>
<td></td>
<td>• Move</td>
</tr>
<tr>
<td></td>
<td>• Copy</td>
</tr>
<tr>
<td>General/control register access function</td>
<td>Reads or writes the general/control register.</td>
</tr>
<tr>
<td>Internal I/O register access function</td>
<td>Reads or writes the internal I/O register.</td>
</tr>
<tr>
<td>Source-level debugging function</td>
<td>Various source-level debugging functions.</td>
</tr>
<tr>
<td>Command line function</td>
<td>Supports command input.</td>
</tr>
<tr>
<td></td>
<td>Batch processing can be used by creating a file in which each command is sorted in the order of input.</td>
</tr>
<tr>
<td>Start/Stop function</td>
<td>Executes the specified routine of the user program immediately before starting and immediately after halting program execution.</td>
</tr>
<tr>
<td>Help function</td>
<td>Describes the usage of each function as well as the command syntax that can be entered from the command line window.</td>
</tr>
</tbody>
</table>

The specific functions of the emulator are described in the next section.
2.2 Trace Functions

The branch source addresses, mnemonics, operands, and source lines are displayed. Real-time trace acquisition is supported by the trace buffer incorporated in the device.

Note: The MCUs which have no trace function cannot use this function.

2.3 Break Functions

The E8a emulator has the following four break functions.

(1) Hardware break function
Uses a break controller incorporated in the device.
The access address, instruction fetch address, data, or bus cycle condition can be set.
This function can also be set from the [Event] column in the [Source] window. For the setting, refer to section 5.3.1 Address Interrupt Breakpoints.

Note: The MCUs which have no hardware break function cannot use this function.

(2) PC break function (BREAKPOINT)
Breaks when the dedicated instruction at the specified address that has been replaced is executed.
This function can be set on the [Breakpoint] page in the [Eventpoint] dialog box. It can also be set when the [S/W Breakpoints] column for the line to be set is double-clicked in the [Source] or [Disassembly] window.

(3) Forced break function
Forcibly breaks the user program.

(4) Address match break function
Stops the target program immediately before a specified address instruction is executed. This function is featured by the address match interrupt of the MCU. This function can be set from the [Event] column in the Source window. For the setting, refer to section 5.2.2, Viewing the Source Code.

Note: The address match break points vary depending on the device. And, user program operation when device's address match interrupts are used is not guaranteed.

2.4 Memory Access Functions

The emulator has the following memory access functions.

(1) Memory read/write function
[Memory] window: The memory contents are displayed in the window. Only the amount specified when the [Memory] window is opened can be read. If the memory is written in the [Memory] window, a read in the range displayed in the [Memory] window will occur for updating the window. When the [Memory] window is not to be updated, change the setting in [Lock Refresh] from the popup menu.

me command: A command line function that reads or writes the specified amount of memory at the specified address.
(2) User program downloading function
A load module registered in the workspace can be downloaded. Such module can be selected from [Download Modules] in the [Debug] menu. Downloading is also possible by a popup menu that is opened by right-clicking on the mouse at the load module in the workspace. The user program is downloaded to the RAM or flash memory.

This function can download debugging information required for source-level debugging with the Elf/Dwarf2 or IEEE695 file having the debugging information.

(3) Memory data uploading function
The specified amount of memory from the specified address can be saved in an S-format file.

(4) Memory data downloading function
The memory contents saved in the S-type-formatted file can be downloaded. Select [Load] from the popup menu in the [Memory] window.

(5) Displaying the variable contents
The variable contents specified in the user program are displayed. For the usage of the function for displaying the variable contents, refer to the High-performance Embedded Workshop User’s Manual.

(6) Other memory operation functions
Other functions are as follows:
- Memory fill
- Memory copy
- Memory save
- Memory verify
- Memory search
- Internal I/O display
- Displaying label and variable names and their contents

Notes:
1. Memory access during user program execution:
   When memory is accessed from the memory window, etc. during execution of the user program, execution stops for the memory access and is then resumed. Therefore, realtime emulation cannot be performed.

2. Memory access during user program break:
   The program can also be downloaded and the BREAKPOINT can be set for the flash memory area by the emulator.

3. For the MCUs listed below, memory copy and memory search functions are only available from the addresses described in Table 2.2.

   <Applicable MCUs>
   740 Family
   M32C Series

<table>
<thead>
<tr>
<th>Access Condition</th>
<th>Specifiable Start Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-byte access</td>
<td>No restrictions</td>
</tr>
<tr>
<td>2-byte access</td>
<td>xxx0h, xxx2h, xxx4h, xxx6h, xxx8h, xxxxAh, xxxxCh, xxxxEh</td>
</tr>
<tr>
<td>4-byte access</td>
<td>xxx0h, xxx4h, xxxx8h, xxxxCh</td>
</tr>
<tr>
<td>8-byte access</td>
<td>xxx0h, xxxx8h</td>
</tr>
</tbody>
</table>
2.5 Stack Trace Function

The emulator uses the information on the stack to display the names of functions in the sequence of calls that led to the function to which the program counter is currently pointing. This function can be used only when the load modules that have the following formats are loaded:

- M32C family C compiler (M3T-NC30WA): IEEE695
- M16C family C compiler (M3T-NC30WA): IEEE695
- R8C family C compiler (M3T-NC8C): IEEE695
- H8, H8S, H8SX family C/C++ compiler (such as [R0C40008XSW06R]): Elf/Dwarf2

For the usage of this function, refer to section 6.19, Stack Trace Function.

2.6 Start/Stop Function

The emulator executes the specified routine of the user program immediately before starting and immediately after halting program execution. This function is used to control the user system in synchronization with execution and halting of the user program.

For the usage of this function, refer to section 5.6, Using the Start/Stop Function.

Note: The start/stop function is not supported in the H8/Tiny or H8/Super Low Power series, the 740 family, or the R8C/10, R8C/11, R8C/12, or R8C/13 group.

2.7 Online Help

An online help explains the usage of each function or the command syntax that can be entered from the command line window.

Select [Emulator Help] from the [Help] menu to view the emulator help.
2.8 Regulatory Compliance Notices

● European Union regulatory notices

This product complies with the following EU Directives. (These directives are only valid in the European Union.)

**CE Certifications:**
- Electromagnetic Compatibility (EMC) Directive 2014/30/EU
  - EN 55022 Class A

**WARNING:** This is a Class A product. This equipment can cause radio frequency noise when used in the residential area. In such cases, the user/operator of the equipment may be required to take appropriate countermeasures under his responsibility.

- Information for traceability
  - Authorised representative
    - Name: Renesas Electronics Corporation
    - Address: Toyosu Foresea, 3-2-24, Toyosu, Koto-ku, Tokyo 135-0061, Japan
  - Manufacturer
    - Name: Renesas System Design Co., Ltd.
    - Address: 5-20-1, Josuihon-cho, Kodaira-shi, Tokyo 187-8588, Japan
  - Person responsible for placing on the market
    - Name: Renesas Electronics Europe GmbH
    - Address: Arcadiastrasse 10, 40472 Dusseldorf, Germany
  - Trademark and Type name
    - Trademark: Renesas
    - Product name: E8a Emulator
    - Type name: R0E00008AKCE00

**Environmental Compliance and Certifications:**
- Waste Electrical and Electronic Equipment (WEEE) Directive 2012/19/EU

● United States Regulatory notices

This product complies with the following EMC regulation. (This is only valid in the United States.)

**FCC Certifications:**
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

**CAUTION:** Changes or modifications not expressly approved by the party responsible for compliance could void the user's authority to operate the equipment.
3. Preparation before Use

3.1 Emulator Preparation

Unpack the emulator and prepare it for use as follows:

![Emulator Preparation Flow Chart]

Figure 3.1 Emulator Preparation Flow Chart
3.2 Emulator Hardware Configuration

As shown in Figure 3.2, the emulator consists of an emulator, a USB cable, and a user system interface cable. The emulator is connected to the host computer via USB 1.1, and also to the USB port conforming to USB 2.0.

![Emulator Hardware Configuration](image)

Figure 3.2  Emulator Hardware Configuration
The names of each section of the emulator are explained next.

**Emulator Upper-side Panel:**

![Figure 3.3 Emulator Upper-side Panel](image)

(a) **ACT LED:** An LED to show the operating state of the emulator software. When this LED is lit (yellow-green), the E8a control software is in operation.

(b) **VCC LED:** An LED to show the power state of the user system. When power is supplied from the emulator to the user system, this LED is lit in orange. When power is supplied from the user system to the emulator, this LED is lit in yellow-green.
Emulator Host-Computer-Side Panel:

(a) Host-side connector: A USB cable connector for connecting the emulator to the host computer. Be sure to use the attached USB cable.

(b) Portable strap hole: A hole for the strap (No strap is provided for this product).
Emulator User-System-Side Panel:

![Side view of the emulator (user system side)](image)

Figure 3.5 Side view of the emulator (user system side)

(a) Connector to the user system: Used for connecting the user interface cable.
Emulator Bottom Panel:

![Emulator Bottom Panel](image)

**Figure 3.6  Emulator Bottom Panel**

(a) Label for product management: The serial No. and information provided on the label differ depending on the time of purchase.
Emulator Left-Side Panel:

Figure 3.7 Emulator Left-Side Panel

(a) Self-check connector: The user interface cable is connected here when conducting E8aSCP (Self Check Program).

(b) Self-check connector cover: To be closed when you are not running E8aSCP.
3.3 Emulator Software Configuration

The following item is included with the emulator debugger when it is purchased:
- E8a Emulator Software: R0E00008AKCE00SR (CD)

3.3.1 CD

Install the software according to the instruction message that will be displayed when you insert the attached CD-ROM to the host machine. The following files and programs are contained in each folder.

Table 3.1 Contents of the CD Directories

<table>
<thead>
<tr>
<th>Directory Name</th>
<th>Contents</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dlls</td>
<td>Microsoft® runtime library</td>
<td>A runtime library for the High-performance Embedded Workshop. The version is checked at installation and this library is copied to the hard disk as part of the installation process.</td>
</tr>
<tr>
<td>Drivers</td>
<td>E8a emulator driver</td>
<td>The E8a emulator drivers.</td>
</tr>
<tr>
<td>Help</td>
<td>Online help for the E8a emulator</td>
<td>An online help file</td>
</tr>
<tr>
<td>Manuals</td>
<td>E8a emulator manual</td>
<td>E8a emulator user's manual. This is provided as a PDF file.</td>
</tr>
</tbody>
</table>

3.4 Installing Emulator’s Debugger

After setting the CD, execute HewInstMan.exe from the root directory on the CD. Then, follow the install wizard to complete the installation.
3.5 Connecting the Emulator to the Host Computer

This section describes how to connect the emulator to the host computer. For the position of each connector of the emulator, refer to section 3.2, Emulator Hardware Configuration.

Notes:
1. When [Add New Hardware Wizard] is displayed, select the [Search for the best driver for your device. (Recommended)] radio button and then the [Specify a location] check box to select the path to be searched for drivers. The location must be specified as <Drive>:\DRIVERS. (<Drive> is the CD drive name.)
2. Be sure to install the emulator’s debugger before putting the emulator in place.

---

**WARNING**

**Warnings for Power Activation:**
Always switch OFF the emulator product and the user system before connecting or disconnecting any cables except for the USB interface cable. Failure to do so will result in a fire hazard and will damage the user system and the emulator product or will result in personal injury. The user program will be lost.

---

The emulator is connected to the host computer via the USB 1.1, and also to the USB port conforming to USB 2.0. Figure 3.8 shows the system configuration.

---

**Figure 3.8 System Configuration when Connecting the Emulator to the Host Computer**
3.6 Connecting the Emulator to the User System

Use the procedure below to connect the emulator to the user system with the user system interface cable, or to disconnect them when moving the emulator or the user system.

1. Check that the host computer is turned off or the emulator is not connected to the host computer with the USB cable.
2. Connect the user system interface cable to the user-side connector of the emulator.
3. Connect the USB cable to the host-computer-side connector of the emulator.

(1) The connector must be installed on the user system. Table 3.2 shows the recommended connector for the emulator.

**Table 3.2 Recommended Connector**

<table>
<thead>
<tr>
<th>Type Number</th>
<th>Manufacturer</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>2514-6002</td>
<td>3M Limited</td>
<td>14-pin straight type</td>
</tr>
</tbody>
</table>

Note: When the connector is installed on the user system, do not install any components within 3 mm of the connector.

(2) The pin assignments of the connector are shown in the section of ‘Pin Assignments of the E8/E8a Connector’ in the additional documents for the E8a emulator user’s manual.

![Diagram](image)

**Figure 3.9** Connecting the User System Interface Cable to the User System

Notes:
1. To connect the signals output from the E8a connector, refer to the MCU pin alignment.
2. To remove the user system interface cable from the user system, pull the connector upward.
3. The range of frequencies that the emulator operates at is different according to the MCUs used.
4. Connect the signals from the E8a connector as shown in section 3 or section 4 in the additional documents for the E8a emulator user’s manual.
3.7 Connecting System Ground

**WARNING**

**Warnings for Connecting Ground:**
Separate the frame ground from the signal ground at the user system. Failure to do so will result in a fire hazard and will damage the user system and the emulator product or will result in personal injury.

The emulator's signal ground is connected to the user system's signal ground. In the emulator, the signal ground and frame ground are connected. In the user system, connect the frame ground only; do not connect the signal ground to the frame ground (Figure 3.10).

![Diagram of Connecting System Ground](image)

**Figure 3.10 Connecting System Ground**
3.8 System Check

When the software is executed, use the procedure below to check that the emulator is connected correctly. Here, use the workspace for a tutorial provided on the product.

Refer to section 4, Preparations for Debugging, for the other activating method to create a new project or use a workspace for the High-performance Embedded Workshop of the old version.

1. Connect the emulator to the host computer.
2. Connect the user system interface cable to the connector of the emulator.
3. Connect the user system interface cable to the connector in the user system.
5. The [Welcome!] dialog box is displayed.

![Welcome! dialog box]

**Figure 3.11 [Welcome!] dialog box**

- [Create a new project workspace] radio button: Creates a new workspace.
- [Open a recent project workspace] radio button: Uses the current workspace and displays the history of the opened workspace.
- [Browse to another project workspace] radio button: Uses the current workspace; this radio button is used when the history of the opened workspace does not remain

To use a workspace for the tutorial, select the [Browse to another project workspace] radio button and click the [OK] button.
6. When the [Open workspace] dialog box is opened, specify the following directory:
   <OS installation directory>
   \WorkSpace\Tutorial\E8a\xxxx\Tutorial
   After the directory has been specified, select the following file and click the [Open] button.

   ![Open Workspace Dialog Box](image)

   **Figure 3.12  [Open Workspace] Dialog Box**

   **Note:**
   The directory for a tutorial differs depending on the device.
   - **M32C**
     Drive where the OS has been installed: \WorkSpace\Tutorial\E8a\M32C\Tutorial
   - **M16C**
     Drive where the OS has been installed: \WorkSpace\Tutorial\E8a\M16C\Tutorial
   - **R8C**
     Drive where the OS has been installed: \WorkSpace\Tutorial\E8a\R8C\Tutorial
   - **740**
     Drive where the OS has been installed: \WorkSpace\Tutorial\E8a\740\Tutorial
   - **H8/Tiny normal mode**
     Drive where the OS has been installed: \WorkSpace\Tutorial\E8a\H8\Tutorial
   - **H8/Tiny advanced mode**
     Drive where the OS has been installed: \WorkSpace\Tutorial\E8a\H8\TutorialADV
   - **H8/Super Low Power**
     Drive where the OS has been installed: \WorkSpace\Tutorial\E8a\H8\TutorialSLP
7. The [Emulator Setting] dialog box is displayed.

![Figure 3.13  [Emulator Setting] Dialog Box](image)

Select the device name in use from the [MCU Group] drop-down list box.

Note: The [MCU Group] drop-down list box is not displayed in the H8/Tiny or H8/Super Low Power series.

Select the device name in use from the [Device] drop-down list box.

The following items are selected in the [Mode] group box.

- **Erase Flash and Connect**
  This mode is used to erase data of the MCU flash memory and activate the debugger. A program for the emulator is also written to at the same time.

Note: The emulator occupies the user’s flash memory area according to the target MCUs. For details, refer to the additional document, Notes on Connecting the xxxx.

- **Keep Flash and Connect**
  This mode is used to activate the debugger while retaining data of the MCU flash memory. However, areas for the emulator program and vector areas used by the emulator will be changed.

- **Program Flash**
  This mode is used when the emulator is used as a flash memory programmer. It cannot be used for debugging programs.
  Register the load module in the workspace to download it.
Note: It is necessary to input the ID code of the flash memory by the target device. For details, refer to the additional document, Notes on Connecting the xxxx.

— Debugging of CPU rewrite mode
This mode is used to debug the program that rewrites the CPU. In this mode, the following debug operations, which require reprogramming of the flash memory, are not available:
- Setting the PC breakpoint
- Changing the memory contents in the flash memory area
The debugger is activated by erasing data of the MCU flash memory. A program for the emulator program is also written to at the same time.

Note: This mode is not supported in the H8/Tiny or H8/Super Low Power series.

When the [Execute the user program after ending the debugger.] check box is selected, the user program is executed at the same time as the debugger operation is ended with the emulator connected to the user system. This check box is only available when the [Program Flash] mode has been selected.

When the [Power Target from Emulator. (MAX 300mA)] check box is selected, power will be supplied to the user system up to 300 mA. Then select 3.3 V or 5.0 V according to the power voltage of the user system.

CAUTION

Cautions to Be Taken for Power Supply:
Before carrying out the power supply, check the power specification of the user system and there is no short circuit in the user system. Incorrect operation will damage the user system and the emulator product. The user program will be lost.

8. The [Connecting] dialog box is displayed and the emulator connection is started.

Figure 3.14  [Connecting] Dialog Box
9. When the version of the E8a firmware downloaded into the emulator is old, the message box shown in Figure 3.15 will be displayed.

![Figure 3.15 Dialog Box for confirming the E8a firmware download](image)

**Note:** When [OK] button is clicked, it starts downloading the E8a firmware. Do not connect/disconnect the USB cable until the download status dialog box closes.

10. When [Power Target from Emulator. (MAX 300mA)] is not checked, the dialog box shown in Figure 3.16 will be displayed.

![Figure 3.16 Dialog Box of the Power-on Request Message](image)

11. If no power is supplied to the user system, the dialog box for confirming the power supply status of the user system will be displayed.

![Figure 3.17 [Power Supply] Dialog Box](image)

When no power is supplied from the emulator, click the [OK] button without selecting the [Power Target from Emulator. (MAX 300mA)] check box.

When power is supplied from the emulator, select the [Power Target from Emulator. (MAX 300mA)] check box and select 3.3 V or 5.0 V according to the power voltage of the user system.
Cautions to Be Taken for Power Supply:

Before carrying out the power supply, check the power specification of the user system and there is no short circuit in the user system. Incorrect operation will damage the user system and the emulator product. The user program will be lost.

12. When “Connected” is displayed in the [Output] window of the High-performance Embedded Workshop, the emulator initiation is completed.

Note: When the user program has already been downloaded to the flash memory, source-level debugging cannot be executed because there is no debugging information on the user program after the emulator has been activated. Be sure to load the debugging information file. For details, refer to section 4.2.1, Setting at Emulator Activation.
Notes: 1. If the user system interface cable is disconnected from the connector on the user system, the following dialog box will appear.

![Connector disconnected] Dialog Box

Figure 3.19  [Connector disconnected] Dialog Box

2. If the emulator is not properly initialized, one of the dialog boxes shown in Figures 3.20 through 3.24 will appear.

(a) The following dialog box is displayed when the flash memory cannot be erased. Exchange the MCU since the flash memory has been programmed more times than the limitation.

![Flash memory erase error!] Dialog Box

Figure 3.20  [Flash memory erase error!] Dialog Box

(b) The following dialog box is displayed when the flash memory cannot be programmed. An incorrect system clock value has been input or the flash memory has been programmed more times than the limitation.

![Error sending Flash memory write program] Dialog Box

Figure 3.21  [Error sending Flash memory write program] Dialog Box
(c) The following dialog box is displayed when an incorrect ID code has been input. For the H8/Tiny, H8/Super Low Power, R8C/10, 11, 12 and 13, if an ID code does not match, the flash memory will be completely erased.

![ID code error! Dialog Box](image)

**Figure 3.22 [ID code error!] Dialog Box**

(d) The following dialog box is displayed when the MCU cannot communicate with the emulator. Check the MCU settings.

![Boot Failed! Dialog Box](image)

**Figure 3.23 [Boot Failed!] Dialog Box**

3. If an incorrect driver has been selected, the following dialog box will appear.

![Unable to restore the previous driver settings Dialog Box](image)

**Figure 3.24 [Unable to restore the previous driver settings] Dialog Box**
4. Preparations for Debugging

4.1 Method for Activating High-performance Embedded Workshop

To activate the High-performance Embedded Workshop, follow the procedure listed below.

1. Connect the emulator to the host computer and the user system, then turn on the user system.
3. The [Welcome!] dialog box is displayed.

![Welcome!] Dialog Box

- **[Create a new project workspace] radio button**: Creates a new workspace.
- **[Open a recent project workspace] radio button**: Uses the current workspace and displays the history of the opened workspace.
- **[Browse to another project workspace] radio button**: Uses the current workspace; this radio button is used when the history of the opened workspace does not remain.

In this section, we describe the following three ways to start up the High-performance Embedded Workshop:

- [Create a new project workspace] - a toolchain is not in use
- [Create a new project workspace] - a toolchain is in use
- [Browse to another project workspace]

The [Open a recent project workspace] radio button is used to omit the operation for specifying the workspace file when [Browse to another project workspace] is selected.
4.1.1 Creating the New Workspace (Toolchain Not Used)

1. In the [Welcome!] dialog box that is displayed when the High-performance Embedded Workshop is activated, select [Create a new project workspace] radio button and click the [OK] button.

![Figure 4.2: [Welcome!] Dialog Box](image)
2. The Project Generator is started. This section omits the description on the setting for the toolchain. If you have not purchased the toolchain, the following dialog box is displayed.

![New Project Workspace Dialog Box]

Figure 4.3  [New Project Workspace] Dialog Box

- **[Workspace Name] edit box**: Enter the new workspace name. Here, enter ‘test’.
- **[Project Name] edit box**: Enter the project name. When the project name is the same as the workspace name, it needs not be entered.
- **[CPU family] drop-down list box**: Select the target CPU family.
  - M32C: Select [M16C/80, M32C]
  - R8C, M16C: Select [M16C].
  - 740: Select [740 Family].
  - H8S Tiny/H8 Tiny/Super Low Power: Select [H8S,H8/300].
- **[Tool chain] drop-down list box**: Here, select [None].

Other list boxes are used for setting the toolchain; the fixed information is displayed when the toolchain has not been installed.
3. The following dialog box is displayed.

![Setting the Target System for Debugging](image)

**Figure 4.4 [Setting the Target System for Debugging] Dialog Box**

Select the target system for debugging and click the [Next] button.

- **[Target system for debuggin**g]**
  - M32C E8a SYSTEM:
  - M16C E8a SYSTEM:
  - R8C E8a SYSTEM:
  - 740 E8a SYSTEM:
  - H8S Tiny:
  - H8 Tiny/Super Low Power E8a SYSTEM 300H:
  - H8 Tiny/Super Low Power E8a SYSTEM 300L:

- **[Target MCU]**
  - M32C
  - M16C
  - R8C/Tiny
  - 740
  - H8S/Tiny E8a SYSTEM
  - H8/300H Tiny, H8/300H Super Low Power
  - H8/300 Super Low Power
4. Set the configuration file name. The configuration file saves the setting of the High-performance Embedded Workshop except the emulator.

![Setting the Debugger Options Dialog Box](image)

**Figure 4.5  [Setting the Debugger Options] Dialog Box**

This is the end of the emulator setting. Click the [Finish] button to exit the Project Generator. The High-performance Embedded Workshop is activated.

5. After the High-performance Embedded Workshop has been activated, the emulator is automatically connected. For operation during connection, refer to section 3.8, System Check.
4.1.2 Creating the New Workspace (Toolchain Used)

1. In the [Welcome!] dialog box that is displayed when the High-performance Embedded Workshop is activated, select [Create a new project workspace] radio button and click the [OK] button.

![Welcome! Dialog Box]

Figure 4.6 [Welcome!] Dialog Box

2. The Project Generator is started.
   If you have purchased the toolchain, the following dialog box is displayed.

![New Project Workspace Dialog Box]

Figure 4.7 [New Project Workspace] Dialog Box

- **[Workspace Name] edit box**: Enter the new workspace name. Here, enter ‘test’.
- **[Project Name] edit box**: Enter the project name. When the project name is the same as the workspace name, it needs not be entered.
- **[CPU family] drop-down list box**: Select the target CPU family.
- **[Tool chain] drop-down list box**: Select the target toolchain name when using the toolchain. Otherwise, select [None].
- **[Project type] list box**: Select the project type to be used.
3. Make the required setting for the toolchain.

![Figure 4.8](#)  
**Figure 4.8**  [New Project-1/6-Select Target CPU. Toolchain version] Dialog Box  
Select your toolchain version, CPU series and click the [Next] button.

4. Make the required settings for the RTOS.

![Figure 4.9](#)  
**Figure 4.9**  [New Project-2/6-Select RTOS] Dialog Box  
Select the RTOS you use, type of startup file and click the [Next] button.

Note: In the H8/Tiny, H8/Super Low Power series, and 740 family, this dialog box will not be displayed.
5. Make the required settings for the heap area etc.

![Image](image1.png)

**Figure 4.10** [New Project-3/6-Setting the Contents of Files to be Generated] Dialog Box

Set the heap size etc. and click the [Next] button.

**Note:** In the H8/Tiny, H8/Super Low Power series, and 740 family, the content of the dialog box will differ.

6. Make the required setting for the stack area.

![Image](image2.png)

**Figure 4.11** [New Project-4/6-Setting the Stack Area] Dialog Box

Set the stack size and click the [Next] button.
7. When the tool chain settings have been completed, the following dialog box is displayed.

![Image](image.png)

**Figure 4.12  [New Project-5/6-Setting the Target System for Debugging] Dialog Box**

Select the target system for debugging and click the [Next] button.

- **Target system for debugging**
  - M32C E8a SYSTEM: M32C
  - M16C E8a SYSTEM: M16C
  - R8C E8a SYSTEM: R8C/Tiny
  - 740 E8a SYSTEM: 740
  - H8S Tiny:
  - H8 Tiny/Super Low Power E8a SYSTEM 300H: H8/300H Tiny, H8/300H Super Low Power
  - H8 Tiny/Super Low Power E8a SYSTEM 300L: H8/300 Super Low Power

Select another product, if necessary.
8. Set a configuration file name. The configuration file saves the settings of the High-performance Embedded Workshop except for the emulator.

![Figure 4.13](image1.png)  
**Figure 4.13** [New Project-6/7-Setting the Debugger Options] Dialog Box

9. Finally, confirm the file name you create.

![Figure 4.14](image2.png)  
**Figure 4.14** [New Project-7/7-Changing the File Names to be Created] Dialog Box

The files which will be generated by the High-performance Embedded Workshop are displayed. If you want to change the file name, select and click it then enter the new name.

This is the end of the emulator settings. Exit the Project Generator following the instructions on the screen. The High-performance Embedded Workshop is activated.
10. After the High-performance Embedded Workshop has been activated, connect the emulator. However, it is not needed to connect the emulator immediately after the High-performance Embedded Workshop has been activated. To connect the emulator, use one of the methods (a) and (b) below. For operation during connection, refer to section 3.8, System Check.

(a) Connecting the emulator after the setting at emulator activation
Select [Debug settings…] from the [Debug] menu to open the [Debug Settings] dialog box. It is possible to register the download module or the command chain that is automatically executed at activation. For details on the [Debug Settings] dialog box, refer to section 4.2, Setting at E8a Emulator Activation. The emulator will be connected once the [Debug Settings] dialog box is set and closed.

(b) Connecting the emulator without the setting at emulator activation
The emulator can be easily connected by switching to a session file with which the settings for using the emulator are already registered.

Figure 4.15 Selecting the Session File

In the list box that is circled in Figure 4.15, select the session file name including the character string that has been set in the [Target name] text box in Figure 4.13, [New Project-6/7-Setting the Debugger Options] dialog box. The setting for using the emulator has been registered in this session file.

After selected, the emulator is automatically connected.
4.1.3 Selecting an Existing Workspace

1. In the [Welcome!] dialog box that is displayed when the High-performance Embedded Workshop is activated, select [Browse to another project workspace] radio button and click the [OK] button.

![Figure 4.16 [Welcome!] Dialog Box](image1)

2. The [Open Workspace] dialog box is displayed. Select a directory in which you have created a workspace. After that, select the workspace file (.hws) and press the [Open] button.

![Figure 4.17 [Open Workspace] Dialog Box](image2)

3. This activates the High-performance Embedded Workshop and recovers the state of the selected workspace at the time it was saved. When the saved state information of the selected workspace includes connection to the emulator, the emulator will automatically be connected. To connect the emulator when the saved state information does not include connection to the emulator, refer to section 4.1.2, Creating the New Workspace (Toolchain Used).
4.2 Setting at E8a Emulator Activation

4.2.1 Setting at Emulator Activation

When the emulator is activated, the command chain can be automatically executed. It is also possible to register multiple load modules to be downloaded. The registered load modules are displayed on the workspace window.

1. Select [Debug Settings…] from the [Debug] menu to open the [Debug Settings] dialog box.

![Debug Settings Dialog Box (Target Page)](image)

Figure 4.18 [Debug Settings] Dialog Box ([Target] Page)

2. Select the product name to be connected in the [Target] drop-down list box.
3. Select the format of the load module to be downloaded in the [Default Debug Format] drop-down list box, then register the corresponding download module in the [Download Modules] list box.
4. Click the [Options] tab.
The command chain that is automatically executed at the specified timing is registered. The following three timings can be specified:

- At connecting the emulator
- Immediately before downloading
- Immediately after downloading

Specify the timing for executing the command chain in the [Command batch file load timing] drop-down list box. In addition, register the command-chain file that is executed at the specified timing in the [Command Line Batch Processing] list box.
4.2.2 Downloading a Program

A download module is added under [Download modules] in the [Workspace] window.

Open the load module of [Download modules] in the [Workspace] window by clicking the right-hand mouse button and select [Download module] to start downloading the module.

![Figure 4.20 Download Menu of the [Workspace] Window ([Projects])](image)

Notes:
1. When load modules are downloaded, select [Debug] -> [Download] -> [All Download modules].
2. The emulator downloads programs to the flash memory just before execution of the user program.
4.2.3 Setting the [Program Flash] Mode

The following describes the procedures when the emulator is used as the programming tool. The load module to be downloaded to the new workspace is registered and programmed.

(a) Select the new project workspace.

![Figure 4.21](image1)

**Figure 4.21** [New Project Workspace] Dialog Box

(b) Select the target MCU and click the [Next] button.

![Figure 4.22](image2)

**Figure 4.22** [Setting the Target System for Debugging] Dialog Box
(c) Set a configuration file name and click the [Finish] button.

![Setting the Debugger Options Dialog Box](image)

Figure 4.23  [Setting he Debugger Options] Dialog Box
(d) The [Emulator Setting] dialog box is displayed.

![Emulator Setting Dialog Box](image)

**Figure 4.24  [Emulator Setting] Dialog Box**

Select the [Program Flash] mode.

When the [Power Target from Emulator. (MAX 300mA)] check box is selected, power will be supplied to the user system up to 300 mA. Then select 3.3 V or 5.0 V according to the power voltage of the user system.

(e) When [Power Target from Emulator. (MAX 300mA)] is not checked, the dialog box shown in Figure 4.25 will be displayed.

![Dialog Box of Power-on request message](image)

**Figure 4.25  Dialog Box of Power-on request message**

When [Power Target from Emulator. (MAX 300mA)] is not checked, turn on the user system.
(f) Enter the ID code printed on the flash memory.

![ID Code verification Dialog Box](image)

**Figure 4.26 [ID Code verification] Dialog Box**

Note: Opening the [ID Code verification] dialog box in [Program Flash] mode depends on the target device. For details, refer to the additional document, Notes on Connecting the xxxx.

(g) Select [Debug Settings…] from the [Debug] menu.

![High-performance Embedded Workshop Window](image)

**Figure 4.27 High-performance Embedded Workshop Window**
(h) Select the target MCU and then the download module with the [Add...] button.

![Debug Settings Dialog Box (Target Page)](image)

Figure 4.28  [Debug Settings] Dialog Box ([Target] Page)

(i) The download file is displayed on [Projects].

![Workspace Window (Projects)](image)

Figure 4.29  [Workspace] Window ([Projects])
(j) Select and download the file with the right-hand mouse button.

![Download Menu of the [Workspace] Window ([Projects])](image)

Figure 4.30  Download Menu of the [Workspace] Window ([Projects])

(k) The dialog box for sum checking is displayed and writing is completed.

![Message for Completion of Flash Memory Writing](image)

Figure 4.31  Message for Completion of Flash Memory Writing

(l) When the following dialog box is displayed, close and restart or exit the workspace.

![Message for Restarting or Exiting the [Program Flash] Mode](image)

Figure 4.32  Message for Restarting or Exiting the [Program Flash] Mode
5. Debugging

This section describes the debugging operations and their related windows and dialog boxes. For details on the common functions of the High-performance Embedded Workshop products, refer to the High-performance Embedded Workshop User’s Manual.

5.1 Setting the Environment for Emulation

5.1.1 Opening the [Configuration] Dialog Box

Selecting [Setup -> Emulator -> System...] or clicking the [Emulator System] toolbar button opens the [Configuration] dialog box.

5.1.2 [General] Page

Sets the emulator operation conditions.

![Configuration Dialog Box (General Page)](image)

Figure 5.1 [Configuration] Dialog Box ([General] Page)
Items that can be displayed in the sheet are listed below.

[Device] combo box Displays the MCU name.

[Emulation mode] combo box Selects the emulation mode at user program execution.
Select Normal to perform normal emulation.
Select No break to disable PC breakpoint or break condition settings during emulation.

[User interface clock] combo box Displays the transfer clock of the user interface.

[Flash memory synchronization] combo box Selects whether or not the contents of the flash memory are acquired by the emulator when the user program is stopped or the position where the PC break is set is put back as the original code.
When the flash memory is not programmed by the user program, its contents need not be acquired by the emulator.
If there is no problem with the state that the program in the flash memory has been replaced as the PC break code, the position where the PC break is set needs not be put back as the original code.
Disable: Read or program is not performed for the flash memory except when the emulator is activated, the flash memory area is modified, and the settings of the PC break to the flash memory area are changed.
PC to flash memory: When the user program is stopped, the specified PC break code is replaced as the original instruction. Select this option if there is a problem with the state that the program in the flash memory has been replaced as the PC break code.
Flash memory to PC: When the user program is stopped, the contents of the flash memory are read by the emulator. Select this option if the flash memory is reprogrammed by the user program.
PC to flash memory, Flash memory to PC: When the user program is stopped, the contents of the flash memory are read by the emulator and the specified PC break code is replaced as the original instruction. Select this option if the flash memory is reprogrammed by the user program and there is a problem with the state that the program in the flash memory has been replaced as the PC break code.

Note: This dialog box differs depending on products. For details, refer to the online help.
5.2  Downloading a Program

This section describes how to download a program and view it as source code or assembly-language mnemonics.

Note: After a break has been detected, the High-performance Embedded Workshop displays the location of the program counter (PC). In most cases, for example if an Elf/Dwarf2-based project is moved from its original path (at the build), the source file may not be automatically found. In this case, the High-performance Embedded Workshop will open a source file browser dialog box to allow you to manually locate the file.

5.2.1  Downloading a Program

A load module to be debugged must be downloaded.

To download a program, select the load module from [Debug -> Download] or select [Download] from the popup menu opened by clicking the right-hand mouse button on the load module in [Download modules] of the [Workspace] window.

Note: Before downloading a program, it must be registered to the High-performance Embedded Workshop as a load module. For registration, refer to section 4.2, Setting at E8a Emulator Activation.

5.2.2  Viewing the Source Code

Select a source file name in the [Workspace] window and click [Open] in the popup menu to make the High-performance Embedded Workshop display the source file in the editor. It is also possible to display your source files by double-clicking on their names in the [Workspace] window.

![Source Window](image-url)
In this window, the following items are shown on the left as line information.

The first column (Line Number column) Line number

The second column (Source address column): Address information

The third column (Event column): Event information (break condition)

The fourth column (S/W Breakpoints column): PC, bookmark, and breakpoint information

The right window that shows the source is called as the [Source] window.

- Line Number column
  A line number for the current source file is displayed.

- Source address column
  When a program is downloaded, an address for the current source file is displayed on the Source address column. These addresses are helpful when setting the PC value or a breakpoint.

Event column
The Event column displays the following item:

- : An address condition as a break condition is set.
- : An address interrupt break is set.

This is also set by using the popup menu.

The bitmap symbol above is shown by double-clicking the Event column. This is also set by using the popup menu.

---

**Figure 5.3 Popup Menu**

S/W Breakpoints column
S/W Breakpoints column displays the following items:

- : A bookmark is set.
- : A PC Break is set.
- : PC location
To switch off a column in all source files

1. Click the right-hand mouse button on the [Source] window or select the [Edit] menu.
2. Click the [Define Column Format...] menu item.
3. The [Global Editor Column States] dialog box is displayed.
4. A check box indicates whether the column is enabled or not. If it is checked, the column is enabled. If the check box is gray, the column is enabled in some files and disabled in others. Deselect the check box of a column you want to switch off.
5. Click the [OK] button for the new column settings to take effect.

![Global Editor Column States Dialog Box](image)

**Figure 5.4 [Global Editor Column States] Dialog Box**

To switch off a column in one source file

1. Open the source file which contains the column you want to remove and click the [Edit] menu.
2. Click the [Columns] menu item to display a cascaded menu item. The columns are displayed in this popup menu. If a column is enabled, it has a tick mark next to its name. Clicking the entry will toggle whether the column is displayed or not.
5.3 Stopping Your Program

This section describes how you can halt execution of your application's code. This section describes how to stop the program by setting an address match breakpoints at specific locations in your code.

5.3.1 Address Match Breakpoints

When you are trying to debug your program you will want to be able to stop the program running when it reaches a specific point or points in your code. You can do this by setting the address match breakpoint on the line or instruction at which you want the execution to stop. The following instructions will show you how to quickly set and clear address match breakpoint.

- To set a PC breakpoint in the [Source] window
  1. Make sure that the [Disassembly] or [Source] window is open at the place you want to set a PC breakpoint.
  2. Double-click in the event column at the line which you want the program to stop.
  3. You will see a blue circle appear in the column to indicate that an address match breakpoint has been set.

Now when you run your program and it reaches the address at which you set the address match breakpoint, execution halts with the message "BREAK CONDITION" displayed in the [Debug] sheet of the [Output] window, and the [Source] or [Disassembly] window is updated with the address match breakpoint line marked with an arrow in the gutter.

Note: When a break occurs, the program stops just before it is about to execute the line or instruction at which you set an address match breakpoint. If you choose Go or Step after stopping at the address match breakpoint, then the line marked with an arrow will be the next instruction to be executed.

About address match breakpoints, see also section 5.4.13, Setting Break Conditions.
5.4 Using the Event Points

The emulator has the event point function that performs breaking by specifying higher-level conditions along with the PC breakpoints standard for the High-performance Embedded Workshop.

5.4.1 PC Breakpoints

When the instruction of the specified address is fetched, the user program is stopped. Up to 255 points can be set.

5.4.2 Break Conditions

Break conditions can be used for higher-level conditions such as the data condition as well as specification of the single address.

5.4.3 Opening the [Event] Window

Select [View -> Code -> Eventpoints] or click the [Eventpoints] toolbar button (iid) to open the [Event] window.

The [Event] window has the following two sheets:

- [Breakpoint] sheet: Displays the settings made for PC breakpoints. It is also possible to set, modify, and cancel PC breakpoints.

- [Breakcondition] sheet: Displays or sets the settings made for break condition channels.


5.4.4 Setting PC Breakpoints

It is possible to display, modify, and add PC breakpoints on the [Breakpoint] sheet.

![Figure 5.5](image)

**Figure 5.5  [Event] Window ([Breakpoint] Sheet)**

This window displays and sets the breakpoints. Items that can be displayed in the sheet are listed below.

- **[Type]**  
  Breakpoint

- **[State]**  
  Whether the breakpoint is enabled or disabled

- **[Condition]**  
  An address that the breakpoint is set
  Address = Program counter (Corresponding file name, line, and symbol name)

- **[Action]**  
  Operation of the emulator when a break condition is satisfied
  Break: Halts execution

When a breakpoint is double-clicked in this window, the [Set Break] dialog box is opened and break conditions can be modified.

A popup menu containing the following options is available by right-clicking within the window.

- **Add**
  Sets breakpoints. Clicking this item will open the [Set Break] dialog box and break conditions can be specified.

- **Edit**
  Only enabled when one breakpoint is selected. Select a breakpoint to be edited and click this item. The [Set Break] dialog box will open and break conditions can be changed.

- **Enable**
  Enables the selected breakpoint(s).

- **Disable**
  Disables the selected breakpoint(s). When a breakpoint is disabled, the breakpoint will remain in the list; when specified conditions have been satisfied, a break will not occur.

- **Delete**
  Removes the selected breakpoint. To retain the details of the breakpoint but not have it cause a break when its conditions are met, use the Disable option (see section 5.4.8, Disable).
5.4.10  **Delete All**

Removes all breakpoints.

5.4.11  **Go to Source**

Only enabled when one breakpoint is selected. Opens the **Source** window at the address of the breakpoint.
5.4.12 [Set Break] Dialog Box

This dialog box specifies break conditions.

A breakpoint address to be set is specified in the [Address] edit box. Up to 255 breakpoints can be specified.

When [Address] is selected, if an overloaded function or class name including a member function is specified in address, the [Select Function] dialog box opens.

Clicking the [OK] button sets the break conditions. Clicking the [Cancel] button closes this dialog box without setting the break conditions.

Notes on Setting the [Set Break] Dialog Box

1. When an odd address is set for the H8S/Tiny, H8/Tiny and H8/Super Low Power series, the address is rounded down to an even address.
2. A Breakpoint is accomplished by replacing instructions. Accordingly, it can be set only to the flash memory or RAM area. However, a software break cannot be set to the following addresses:
   — An area other than the flash memory or RAM
   — An area occupied by the E8a emulator program
   — An instruction in which Break Condition 1 is satisfied
3. During step execution, a software breakpoint is disabled.
4. A condition set at Break Condition 1 is disabled immediately after starting execution when an instruction at a software breakpoint is executed. A break does not occur even if a condition of Break Condition 1 is satisfied immediately after starting the execution.
5. When execution resumes from the breakpoint address after the program execution stops at the software breakpoint, single-step execution is performed at the address before execution resumes. Therefore, realtime operation cannot be performed.
6. Settings of software breakpoint and Break Condition 1 are invalid while the STEP OVER function is being used.
5.4.13 Setting Break Conditions

On the [Breakcondition] sheet, the settings for break conditions are displayed, modified, and added. For R8C Family, on the [Breakcondition] sheet, the settings for address match breakpoint are displayed, modified, and added.

![Figure 5.7: [Event] Window ([Breakcondition] Sheet)](image)

Note: The items that can be set in this window differ depending on the product. For the settings for each product, refer to the online help.

This window displays and sets the break condition.

Notes on Setting the Break Condition:

1. When [Go to cursor], [Step In], [Step Over], or [Step Out] is selected, the settings of Break Condition 1 are disabled.
2. Setting of Break Condition 1 is disabled when an instruction to which a BREAKPOINT has been set is executed.
3. When step over function is used, the settings of BREAKPOINT and Break Condition 1 are disabled.

Notes on Setting the Break Condition (for R8C Family):

1. When [Go to cursor], [Step In], [Step Over], or [Step Out] is selected, the settings of Break Condition are disabled.
2. Setting of Break Condition is disabled when an instruction to which a BREAKPOINT has been set is executed.
3. Setting of BREAKPOINT is disabled when BREAKPOINT and Break Condition are set at same address.
4. When step over function is used, the settings of BREAKPOINT and Break Condition are disabled.

Items that can be displayed in the sheet are listed below.

- **[Type]** Break channel number
- **[State]** Whether the breakpoint is enabled or disabled
- **[Condition]** A condition that satisfies a break
- **[Action]** Operation of the emulator when a break condition is satisfied
  - Break: Halts execution

When a breakpoint is double-clicked in this window, the [Break condition 1] dialog box is opened and break conditions can be modified. For details on the [Break condition 1] dialog box, refer to the online help for each product.

A popup menu containing the following options is available by right-clicking within the window.
5.4.14  Edit...

Only enabled when one breakpoint is selected. Select a breakpoint to be edited and click this item. The [Break condition 1] dialog box will open and break conditions can be changed.

5.4.15  Enable

Enables the selected break channel(s). A break channel for which no conditions are set cannot be enabled.

5.4.16  Disable

Disables the selected break channel(s). When a break channel is disabled, a break will not occur even if specified conditions have been satisfied.

5.4.17  Delete

Initializes the condition of the selected break channel. To retain the details of the break channel but not have it cause a break when its conditions are met, use the Disable option (see section 5.4.16, Disable).

5.4.18  Delete All

Initializes conditions of all break channels.

5.4.19  Go to Source

Only enabled when one break channel is selected. Opens the [Source] window at address of break channel.

If an address value has not been set to the break channel, this option cannot be used.

5.4.20  Sequential Conditions

Sets the sequential condition of the break channel.

5.4.21  Editing Break Conditions

Handlings for settings other than PC breakpoints and break conditions are common. The following describes examples of such handling.

5.4.22  Modifying Break Conditions

Select a break condition to be modified, and choose [Edit...] from the popup menu to open the dialog box for the event, which allows the user to modify the break conditions. The [Edit...] menu is only available when one break condition is selected.

5.4.23  Enabling Break Conditions

Select a break condition and choose [Enable] from the popup menu to enable the selected break condition.

5.4.24  Disabling Break Conditions

Select a break condition and choose [Disable] from the popup menu to disable the selected break condition. When a break condition is disabled, the break condition will remain in the list, but an event will not occur when the specified conditions have been satisfied.
5.4.25 Deleting Break Conditions

Select a break condition and choose [Delete] from the popup menu to remove the selected break condition. To retain the break condition but not have it cause an event when its conditions are met, use the [Disable] option (see section 5.4.24, Disabling Break Conditions).

5.4.26 Deleting All Break Conditions

Choose [Delete All] from the popup menu to remove all break conditions.

5.4.27 Viewing the Source Line for Break Conditions

Select a break condition and choose [Go to Source] from the popup menu to open the [Source] or [Disassembly] window at the address of the break condition. The [Go to Source] menu is only available when one break condition that has the corresponding source file is selected.

5.4.28 [Break condition x] Dialog Box

Figure 5.8 [Break condition 3] Dialog Box

This page sets the address bus, data bus, and read/write cycle conditions.

Note: The items that can be set in this dialog box differ depending on the product. For the settings for each product, refer to the online help.
The [Address] group box sets address bus conditions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Don't care] check box</td>
<td>Does not set address conditions.</td>
</tr>
<tr>
<td>[Address] radio button</td>
<td>Sets the use of the normal address bus as break conditions.</td>
</tr>
<tr>
<td>[Only program fetched address after]</td>
<td>Sets a break after prefetched address execution as break conditions.</td>
</tr>
<tr>
<td>radio button</td>
<td></td>
</tr>
<tr>
<td>[Address] edit box</td>
<td>Sets the address bus value with a number or a symbol.</td>
</tr>
<tr>
<td>[Mask] edit box</td>
<td>Sets a value to be masked when [User mask] is selected. For masked bits, the</td>
</tr>
<tr>
<td></td>
<td>break condition is satisfied for any values.</td>
</tr>
</tbody>
</table>

The contents of an option will change depending on the radio button selected.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Address] radio button</td>
<td>All options can be set.</td>
</tr>
<tr>
<td>[Only program fetched address after]</td>
<td>The [Address] option can be set.</td>
</tr>
<tr>
<td>radio button</td>
<td></td>
</tr>
</tbody>
</table>

The [Data] group box sets the data bus conditions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Don't care] check box</td>
<td>No data conditions are set.</td>
</tr>
<tr>
<td>[Value] edit box</td>
<td>Sets the data bus with a number.</td>
</tr>
<tr>
<td>[Low byte] radio button</td>
<td>Sets data access size as the lower 8-bit access.</td>
</tr>
<tr>
<td>[High byte] radio button</td>
<td>Sets data access size as the upper 8-bit access.</td>
</tr>
<tr>
<td>[Word] radio button</td>
<td>Sets data access size as the word access.</td>
</tr>
</tbody>
</table>

The [Read/Write] group box sets the read/write cycle conditions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Read/Write] radio button</td>
<td>Sets the read/write cycle conditions as break conditions.</td>
</tr>
<tr>
<td>[Read] radio button</td>
<td>Sets read cycles as break conditions.</td>
</tr>
<tr>
<td>[Write] radio button</td>
<td>Sets write cycles as break conditions.</td>
</tr>
</tbody>
</table>
5.5 Viewing the Trace Information

For the description on the trace function, refer to section 2.2, Trace Functions.

5.5.1 Opening the [Trace] Window

To open the [Trace] window, choose [View -> Code -> Trace] or click the [Trace] toolbar button ( ).

5.5.2 Acquiring Trace Information

The acquired trace information is displayed in the [Trace] window.

![Trace Window](image)

Figure 5.9 [Trace] Window

This window displays the following trace information items:

- **[PTR]**: Pointer to a location in the trace buffer (+0 for the last executed instruction)
- **[IP]**: The amount of acquired trace information
- **[Type]**: Type of branch:
  - BRANCH: branch source
- **[Address]**: Instruction address
- **[Instruction]**: Instruction mnemonic
- **[Source]**: The C/C++ or assembly-language source program
- **[Label]**: Label information

It is possible to hide any column not necessary in the [Trace] window. Selecting a column you want to hide from the popup menu displayed by clicking the right-hand mouse button on the header column hides that column. To display the hidden column, select the column from the said popup menu again.

Note: The number of branch instructions that can be acquired by a trace and the trace display differ depending on the product. For the specification of each product, refer to the online help.

5.5.3 Clearing the Trace Information

When [Clear] is selected from the popup menu, the trace buffer that stores the trace information becomes empty. If several [Trace] windows are open, all [Trace] windows will be cleared as they all access the same buffer.

5.5.4 Saving the Trace Information in a File

Select [Save...] from the popup menu to open the [Save As] file dialog box, which allows the user to save the information displayed in the [Trace] window as a text file. A range can be specified based on the [PTR] number. This file can only be saved; it cannot be reloaded into the [Trace] window.
5.5.5 Viewing the [Source] Window

The [Source] window corresponding to the selected trace record can be displayed in the following two ways:

- Select a trace record and choose [View Source] from the popup menu.
- Double-click a trace record

The [Source] or [Disassembly] window opens and the selected line is marked with a cursor.

5.5.6 Trimming the Source

Choose [Trim Source] from the popup menu to remove the white space from the left side of the source.

When the white space is removed, a check mark is shown to the left of the [Trim Source] menu. To restore the white space, choose [Trim Source] while the check mark is shown.
5.6 Using the Start/Stop Function

The emulator executes the specified routine of the user program immediately before starting and immediately after halting program execution. This function is used to control the user system in synchronization with execution and halting of the user program.

Note: The start/stop function is not supported in the H8/Tiny or H8/Super Low Power series, the 740 family, or the R8C/10, R8C/11, R8C/12, or R8C/13 group.

5.6.1 Opening the [Start/Stop Function Setting] Dialog Box

The routine executed immediately before starting and immediately after halting the user program execution is specified in the [Start/Stop Function Setting] dialog box.

To open the [Start/Stop Function Setting] dialog box, choose [Setup -> Emulator -> Start/Stop Function Setting…] from the [Start] menu.

![Figure 5.10   [Start/Stop Function Setting] Dialog Box](image)

5.6.2 Specifying the Routine to be Executed

It is possible to specify the respective routines immediately before starting and immediately after halting the user program execution.

When the [The specified routine is executed immediately before execution of the user’s program.] check box is selected, the routine specified in the [starting address] combo box, which is below this check box, is executed immediately before starting user program execution.

If no specified routine is executed immediately before starting user program execution, do not select the [The specified routine is executed immediately before execution of the user’s program.] check box.

When the [The specified routine is executed immediately after the stop of the user’s program.] check box is selected, the routine specified in the [starting address] combo box, which is below this check box, is executed immediately after halting user program execution.

If no specified routine is executed immediately after halting user program execution, do not select the [The specified routine is executed immediately after the stop of the user’s program.] check box.
5.6.3 Restrictions on the Start/Stop Function

The start/stop function has the following restrictions.

- Do not change the SFR used by the firmware.
- When the watchdog timer is used, refresh the watchdog timer in the specified routine.
- Do not set any breakpoints in the specified routine.
- When a stack is used in the specified routine, be sure to use the user stack.
- A register value is undefined when execution of the specified routine is started. While it is possible to change the register value in the specified routine, the following register and flags have restrictions.

<table>
<thead>
<tr>
<th>Register and Flag Names</th>
<th>Restrictions</th>
</tr>
</thead>
<tbody>
<tr>
<td>ISP register</td>
<td>When execution of the specified routine is ended, put the value back to the one at the start of that routine.</td>
</tr>
<tr>
<td>Flag U</td>
<td>Be sure to set the flag value as 0 when execution of the specified routine is ended.</td>
</tr>
<tr>
<td>Flag B</td>
<td>Do not set the flag value as 1 in the specified routine.</td>
</tr>
<tr>
<td>Flag I</td>
<td>No interrupts are allowed during execution of the specified routine. Do not set the flag value as 1 in the specified routine.</td>
</tr>
</tbody>
</table>

- When the content of the [Start/Stop Function Setting] dialog box is changed, the flash memory will be reprogrammed in the block to which the firmware has been allocated upon execution of the user program.

- The specified routine is also executed when the following operations are performed:
  - Step operations
  - Watching or changing memory during user program execution
  - Setting an event break during user program execution
6. Tutorial

6.1 Introduction

This section describes the main functions of the emulator by using a tutorial program.

The tutorial program is based on the C program that sorts ten random data items in ascending or descending order. The tutorial program performs the following actions:

- The main function generates random data to be sorted.
- The sort function sorts the generated random data in ascending order.
- The change function then sorts the data in descending order.

The file tutorial.c contains source code for the tutorial program. The file Tutorial.x30 is a compiled load module in the IEEE695 format.

Notes:

1. After recompilation, the addresses may differ from those given in this section.
2. The file Tutorial.cpp contains source code for the tutorial program of the H8 family devices. The file Tutorial.abs is a compiled load module in the Elf/Dwarf2 format.

6.2 Running the High-performance Embedded Workshop

To run the High-performance Embedded Workshop, refer to section 3.8, System Check.

6.3 Setting up the E8a Emulator

This section describes the basic settings of the E8a emulator.
6.4 Setting the [Configuration] Dialog Box

Select [Emulator] then [Systems...] from the [Setup] menu for the basic settings of the emulator. The [Configuration] dialog box is displayed.

![ConfigurationDialogBox]

Figure 6.1 [Configuration] Dialog Box

Note: The items that can be set in this dialog box differ depending on the product. For the settings for each product, refer to the online help.

Set options as follows:

**Table 6.1 [General] Page Options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device</td>
<td>Select a device you use</td>
</tr>
<tr>
<td>Emulation mode</td>
<td>Normal (normal execution, default)</td>
</tr>
<tr>
<td>User interface clock</td>
<td>According to the system clock frequency, the maximum user interface clock is automatically set.</td>
</tr>
<tr>
<td>Flash memory synchronization</td>
<td>Disable (default)</td>
</tr>
</tbody>
</table>

Click the [OK] button to set a configuration.
6.5 Checking the Operation of RAM

Check that RAM is operating correctly.

Display and edit the contents of the memory in the [Memory] window to check that the memory is operating correctly.

Note: The memory can be installed on the board in some microcomputers. In this case, however, the above way of checking the operation of memory may be inadequate. It is recommended that a program for checking the memory be created.

Select [Memory…] from the [CPU] submenu of the [View] menu and enter the RAM address in the [Display Address] edit box. Here, enter ‘0480’. Then, enter ‘0000’ and ‘FFFF’ in the [Scroll Start Address] and [Scroll End Address] edit boxes, respectively.

![Figure 6.2](image.png)

Note: The settings of the RAM area differ depending on the product. For details, refer to the hardware manual.

Click the [OK] button. The [Memory] window is displayed and shows the specified memory area.

![Figure 6.3](image.png)

Double-clicking on the data area in the Memory Window allows you to change the values. Also, you can directly edit the data at your cursor point without double-clicking it.
6.6 Downloading the Tutorial Program

6.6.1 Downloading the Tutorial Program

Download the object program to be debugged.

With this emulator, you can download programs or set PC breakpoints to the internal flash area. For the method to set the PC breakpoint, refer to section 6.16.1, PC Break Function.

Select [Download] from [Tutorial.x30] under [Download modules].

Figure 6.4 Downloading the Tutorial Program
6.6.2 Displaying the Source Program

The High-performance Embedded Workshop allows the user to debug a user program at the source level.

Double-click [tutorial.c] under [C source file].

![Figure 6.5: Source] Window (Displaying the Source Program)

Select the [Display] option from the [Setup] menu to set a font and size that are legible, if necessary.
Initially the [Source] window shows the start of the user program, but the user can use the scroll bar to scroll through the user program and look at the other statements.
6.7 Setting a PC Breakpoint

A PC breakpoint is a simple debugging function.

The [Source] window provides a very simple way of setting a PC breakpoint at any point in a program. For example, to set a PC breakpoint at the `sort` function call:

Select by double-clicking the [S/W Breakpoints] column on the line containing the `sort` function call.

![Source Window (Setting a PC Breakpoint)]

The symbol • will appear on the line containing the `sort` function. This shows that a PC breakpoint has been set.
6.8 Setting Registers

Set values of the program counter and the stack pointer before executing the program.

Select [Registers] from the [CPU] submenu of the [View] menu. The [Register] window is displayed.

![Figure 6.7 [Register] Window](image)

To change the value of the program counter (PC), double-click the value area in the [Register] window with the mouse. The following dialog box is then displayed, and the value can be changed. Set the program counter to 0E612 in this tutorial program, and click the [OK] button.

![Figure 6.8 [Register] Dialog Box (PC)](image)
6.9 Executing the Program

Execute the program as described in the following:

To execute the program, select [Go] from the [Debug] menu, or click the [Go] button on the toolbar.

![Go Button](image)

**Figure 6.9 [Go] Button**

When the program execution is started, '**RUNNING**' is displayed on the status bar.

The program will be executed up to the breakpoint that has been set, and an arrow will be displayed in the [S/W Breakpoints] column to show the position that the program has halted, with the message [BREAKPOINT] in the status bar.

Note: When the source file is displayed after a break, a path of the source file may be inquired. The location of the source file is as follows:

The High-performance Embedded Workshop is installed to:
\WorkSpace\Tutorial\E8a\xxxx\Tutorial\Source

The directory xxxx varies depending on each device.
- e.g.: M32C
  \WorkSpace\Tutorial\E8a\M32C\Tutorial\Source
- e.g.: M16C
  \WorkSpace\Tutorial\E8a\M16C\Tutorial\Source
- e.g.: R8C
  \WorkSpace\Tutorial\E8a\R8C\Tutorial\Source
- e.g.: 740
  \WorkSpace\Tutorial\E8a\740\Tutorial\Source
- e.g.: H8/Tiny normal mode
  \WorkSpace\Tutorial\E8a\H8\Tutorial
- e.g.: H8/Tiny advanced mode
  \WorkSpace\Tutorial\E8a\H8\TutorialADV
- e.g.: H8/Super Low Power
  \WorkSpace\Tutorial\E8a\H8\TutorialSLP
The user can see the cause of the break that occurred last time in the [Status] window.

Select [Status] from the [CPU] submenu of the [View] menu. After the [Status] window is displayed, open the [Platform] sheet, and check the Status of Cause of last break.

Note: The items that can be set in this window differ depending on the product. For the settings for each product, refer to the online help.
6.10 Reviewing Breakpoints

The user can see all the breakpoints set in the program in the [Event] window.


![Figure 6.12 [Event] Window](image)

The popup menu, opened by clicking the [Event] window with the right-hand mouse button, allows the user to set or change breakpoints, define new breakpoints, and delete, enable, or disable breakpoints.
6.11 Viewing Memory

When the label name is specified, the user can view the memory contents with which the label has been registered in the [Memory] window. For example, to view the memory contents corresponding to \_main in word size:

Select [Memory ...] from the [CPU] submenu of the [View] menu, enter \_main in the [Display Address] edit box, enter 0000 and FFFF in the [Scroll Start Address] and [Scroll End Address] edit boxes, respectively.

![Figure 6.13 [Display Address] Dialog Box](image)

Click the [OK] button. The [Memory] window showing the specified area of memory is displayed.

![Figure 6.14 [Memory] Window](image)
6.12 Watching Variables

As the user steps through a program, it is possible to watch that the values of variables used in the user program are changed. For example, set a watch on the long-type array `a` declared at the beginning of the program, by using the following procedure:

Click the left of displayed array `a` in the [Source] window to position the cursor. Select [Instant Watch...] with the right-hand mouse button.

The following dialog box will be displayed.

![Figure 6.15: [Instant Watch] Dialog Box](image)

Click the [Add] button to add a variable to the [Watch] window.

![Figure 6.16: [Watch] Window (Displaying the Array)](image)

The user can also add a variable to the [Watch] window by specifying its name.
Click the [Watch] window with the right-hand mouse button and select [Add Watch…] from the popup menu.

The following dialog box will be displayed. Enter variable i.

![Add Watch Dialog Box](image)

Figure 6.17 [Add Watch] Dialog Box

Click the [OK] button.

The [Watch] window will now also show the int-type variable i.

![Watch Window (Displaying the Variable)](image)

Figure 6.18 [Watch] Window (Displaying the Variable)

The user can click mark ‘+’ at the left side of array a in the [Watch] window to watch all the elements.

![Watch Window (Displaying Array Elements)](image)

Figure 6.19 [Watch] Window (Displaying Array Elements)
6.13 Stepping Through a Program

The High-performance Embedded Workshop provides a range of step menu commands that allow efficient program debugging.

Table 6.2 Step Option

<table>
<thead>
<tr>
<th>Menu Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step In</td>
<td>Executes each statement, including statements within functions.</td>
</tr>
<tr>
<td>Step Over</td>
<td>Executes a function call in a single step.</td>
</tr>
<tr>
<td>Step Out</td>
<td>Steps out of a function, and stops at the next statement of the calling statement in the main function.</td>
</tr>
<tr>
<td>Step…</td>
<td>Steps for a specified number of times at a specified rate.</td>
</tr>
</tbody>
</table>

6.13.1 Executing [Step In] Command

The [Step In] command steps into the called function and stops at the first statement of the called function.

To step through the `sort` function, select [Step In] from the [Debug] menu, or click the [Step In] button on the toolbar.

![Figure 6.20 [Step In] Button](image)

The highlighted line moves to the first statement of the `sort` function in the [Source] window.

![Figure 6.21 [Source] Window (Step In)](image)

The highlighted line moves to the first statement of the `sort` function in the [Source] window.
6.13.2 Executing [Step Out] Command

The [Step Out] command steps out of the called function and stops at the next statement of the calling statement in the main function.

To step out of the `sort` function, select [Step Out] from the [Debug] menu, or click the [Step Out] button on the toolbar.

Note: It takes time to execute this function. When the calling source is clarified, use [Go To Cursor].

![Figure 6.22 [Step Out] Button](image)

![Figure 6.23 [High-performance Embedded Workshop] Window (Step Out)](image)

The data of variable `a` displayed in the [Watch] window is sorted in ascending order.
6.13.3 Executing [Step Over] Command

The [Step Over] command executes a function call as a single step and stops at the next statement of the main program.

- To step through all statements in the `change` function at a single step, select [Step Over] from the [Debug] menu, or click the [Step Over] button on the toolbar.

---

**Figure 6.24 [Step Over] Button**

![Step Over Button](image)

---

**Figure 6.25 [High-performance Embedded Workshop] Window (Step Over)**

![Debug Window](image)
6.14 Forced Breaking of Program Executions

The High-performance Embedded Workshop can force a break in the execution of a program. Cancel all breaks.

To execute the remaining sections of the main function, select [Go] from the [Debug] menu or the [Go] button on the toolbar.

Figure 6.26 [Go] Button

The program goes into an endless loop. To force a break in execution, select [Halt] from the [Debug] menu or the [Halt] button on the toolbar.

Figure 6.27 [Halt] Button

6.15 Displaying Local Variables

The user can display local variables in a function using the [Locals] window. For example, we will examine the local variables in the main function, which declares four local variables: a, j, i, and p_sam.


The [Locals] window shows the local variables in the function currently pointed to by the program counter, along with their values. Note, however, that the [Locals] window is initially empty because local variables are yet to be declared.

Figure 6.28 [Locals] Window

Click mark ‘+’ at the left side of array a in the [Locals] window to display the elements. When the user refers to the elements of array a before and after the execution of the sort function, it is clarified that random data is sorted in descending order.
6.16 Break Function

The emulator has PC and hardware break functions. With the High-performance Embedded Workshop, a PC breakpoint can be set using the [Breakpoint] sheet of the [Event] window, and a hardware break condition can be set using the [Breakcondition] sheet.

An overview and setting of the break function are described below.

6.16.1 PC Break Function

The emulator can set up to 255 PC breakpoints. Other methods for setting a PC breakpoint than in section 6.7, Setting a PC Breakpoint, are described below.

Select the [Breakpoint] sheet.

![Event Window (Before PC Breakpoint Setting)](image)

Figure 6.29 [Event] Window (Before PC Breakpoint Setting)
Click the [Event] window with the right-hand mouse button and select [Add…] from the popup menu. Enter \texttt{H'0E1FE} in the [Address] edit box.

![Figure 6.30](image1.png) \textit{[Set Break] Dialog Box}

Click the [OK] button.

The PC breakpoint that has been set is displayed in the [Event] window.

![Figure 6.31](image2.png) \textit{[Event] Window (PC Breakpoint Setting)}
To stop the tutorial program at the PC breakpoint, the following procedure must be executed:

Close the [Event] window.

Set the program counter value (PC = H’0E612) that was set in section 6.8, Setting Registers, in the [Register] window.

Click the [Go] button.

If program execution is failed, reset the device and execute again the procedures above.

The program runs, and stops at the set PC breakpoint.

![Figure 6.32 Source Window at Execution Stop (PC Break)](image)

The [Status] window displays the following contents.

![Figure 6.33 Displayed Contents of the [Status] Window (PC Break)](image)

Note: The items that can be set in this window differ depending on the product. For the settings for each product, refer to the online help.
6.17 Hardware Break Function

A method is given below in which the address bus condition is set under Break Condition 1 as hardware break conditions.

The PC breakpoint that has been previously set is deleted. Click the [Event] window with the right-hand mouse button and select [Delete All] from the popup menu to cancel all PC breakpoints that have been set.
To set a Break condition 1, click the [Break condition] tab.
Select a line of Break condition 1 in the [Event] window. When highlighted, double-click this line.

![Figure 6.34](image)

Figure 6.34 [High-performance Embedded Workshop] Window ([Break condition 1])
The [Break condition 1] dialog box is displayed.
Clear the [Don't care] check box in the [Address] group box.
Select the [Only program fetched address after] radio button and enter $H'0E1F2$ as the value in the [Address] edit box.

![Figure 6.35](image)

Click the [OK] button.

The first point display in the State line changes from Disable to Enable.
The first point display in the Condition line changes from None to Address = H’0000E1FE(Tutorial.c/41)pc before.
Set the program counter value (PC = H’0E612) that was set in section 6.8, Setting Registers, in the [Register] window.
Click the [Go] button.

Note: The items that can be set in this page differ depending on the product. For the settings for each product, refer to the online help.
The [Status] window displays the following contents.

Note: The items that can be set in this window differ depending on the product. For the settings for each product, refer to the online help.
6.18  Trace Functions

The emulator has a branch-instruction trace function.

The branch source addresses, mnemonics, operands, source lines, and labels are displayed for four branches.

Note: The trace function uses the trace buffer housed in the device. Devices which have no trace function cannot use this function.

6.18.1  Displaying the Trace Window


Run the program as shown in the example of section 6.16.1, PC Break Function. The trace results are displayed in the [Trace] window after the program execution is completed.

![Figure 6.38  [Trace] Window](image)

If necessary, adjust the column widths by dragging borders in the header bar (immediately below the title bar).

Note: The number of branch instructions that can be acquired by a trace and the trace display differ depending on the product. For the specification of each product, refer to the online help.
6.19 Stack Trace Function

The emulator uses the information on the stack to display the names of functions in the sequence of calls that led to the function to which the program counter is currently pointing.

Note: This function can be used only when the load module that has the IEEE695-type debugging information is loaded. (However, 740 families exclude it.)

Double-click the [S/W Breakpoints] column in the `sort` function and set a PC breakpoint.

![Source Window (PC Breakpoint Setting)](image)

Set the same program counter value (PC = H’0E612) as was set in section 6.8, Setting Registers (again, use the [Register] window). Click the [Go] button.

After the break in program execution, select [Stack Trace] from the [Code] submenu of the [View] menu to open the [Stack Trace] window.

![Stack Trace Window](image)

Figure 6.40 shows that the position of the program counter is currently at the selected line of the `sort()` function, and that the `sort()` function is called from the `tutorial()` function.
6.20 What Next?

This tutorial has described the major features of the emulator and the use of the High-performance Embedded Workshop.

Sophisticated debugging can be carried out by using the emulation functions that the emulator offers. This provides for effective investigation of hardware and software problems by accurately isolating and identifying the conditions under which such problems arise.
### 7. Appendix A: Components of the E8a Emulator

Table A.1 lists the components of the E8a emulator.

<table>
<thead>
<tr>
<th>Classification</th>
<th>Component</th>
<th>Appearance</th>
<th>Quantity</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hardware</td>
<td>E8a emulator (Model: R0E00008AKCE00)</td>
<td><img src="image1.png" alt="E8a Emulator Image" /></td>
<td>1</td>
<td>R0E00008AKCE00: Depth: 42 mm, Width: 92 mm, Height: 15 mm, Mass: 38.0 g</td>
</tr>
<tr>
<td></td>
<td>User system interface cable</td>
<td><img src="image2.png" alt="User System Interface Cable Image" /></td>
<td>1</td>
<td>Length: 150 mm (connector part not included), Mass: 10.0 g</td>
</tr>
<tr>
<td></td>
<td>USB cable</td>
<td><img src="image3.png" alt="USB Cable Image" /></td>
<td>1</td>
<td>Length: 1.5 m, Mass: 42.0 g</td>
</tr>
<tr>
<td>Software</td>
<td>E8a emulator setup program</td>
<td><img src="image4.png" alt="Setup Program Image" /></td>
<td>1</td>
<td>R0E00008AKCE00SR: E8aSCP.EXE</td>
</tr>
<tr>
<td></td>
<td>E8a emulator self-check program</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>E8a Emulator User's Manual</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>E8a Emulator Additional Document for User's</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Manual, Notes on Connecting the xxxxx</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>M32C evaluation compiler</td>
<td><img src="image5.png" alt="M32C Compiler Image" /></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>M16C evaluation compiler</td>
<td><img src="image6.png" alt="M16C Compiler Image" /></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>740 evaluation assembler</td>
<td><img src="image7.png" alt="740 Assembler Image" /></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>H8 evaluation compiler</td>
<td><img src="image8.png" alt="H8 Compiler Image" /></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>M3T-NC308WA</td>
<td><img src="image9.png" alt="M3T-NC308WA Image" /></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>M3T-NC30WA</td>
<td><img src="image10.png" alt="M3T-NC30WA Image" /></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>M3T-SRA74</td>
<td><img src="image11.png" alt="M3T-SRA74 Image" /></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>R0C40008XSW06R</td>
<td><img src="image12.png" alt="R0C40008XSW06R Image" /></td>
<td></td>
<td>(Provided with the E8a emulator setup program)</td>
</tr>
</tbody>
</table>
8. Appendix B: Window Functions

This section describes the window functions that can be used with the High-performance Embedded Workshop for E8a emulator. Here, the High-performance Embedded Workshop common functions are omitted, and only the emulation functions are described.

Table B.1 Window Functions

<table>
<thead>
<tr>
<th>Menu</th>
<th>Option</th>
<th>Shortcut</th>
<th>Toolbar Button</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>View</td>
<td>Disassembly</td>
<td>Ctrl + D</td>
<td><img src="image" alt="Disassembly" /></td>
<td>Opens the [Disassembly] window.</td>
</tr>
<tr>
<td></td>
<td>Command Line</td>
<td>Ctrl + L</td>
<td><img src="image" alt="Command Line" /></td>
<td>Opens the [Command Line] window.</td>
</tr>
<tr>
<td></td>
<td>Workspace</td>
<td>Alt + K</td>
<td><img src="image" alt="Workspace" /></td>
<td>Opens the [Workspace] window.</td>
</tr>
<tr>
<td></td>
<td>Output</td>
<td>Alt + U</td>
<td><img src="image" alt="Output" /></td>
<td>Opens the [Output] window.</td>
</tr>
<tr>
<td>CPU</td>
<td>Registers</td>
<td>Ctrl + R</td>
<td><img src="image" alt="Registers" /></td>
<td>Opens the [Register] window.</td>
</tr>
<tr>
<td></td>
<td>Memory…</td>
<td>Ctrl + M</td>
<td><img src="image" alt="Memory" /></td>
<td>Opens the [Memory] window.</td>
</tr>
<tr>
<td></td>
<td>IO</td>
<td>Ctrl + I</td>
<td><img src="image" alt="IO" /></td>
<td>Opens the [IO] window.</td>
</tr>
<tr>
<td></td>
<td>Status</td>
<td>Ctrl + U</td>
<td><img src="image" alt="Status" /></td>
<td>Opens the [Status] window.</td>
</tr>
<tr>
<td>Symbol</td>
<td>Labels</td>
<td>Shift + Ctrl + A</td>
<td><img src="image" alt="Labels" /></td>
<td>Opens the [Labels] window.</td>
</tr>
<tr>
<td></td>
<td>Watch</td>
<td>Ctrl + W</td>
<td><img src="image" alt="Watch" /></td>
<td>Opens the [Watch] window.</td>
</tr>
<tr>
<td></td>
<td>Locals</td>
<td>Shift + Ctrl + W</td>
<td><img src="image" alt="Locals" /></td>
<td>Opens the [Locals] window.</td>
</tr>
<tr>
<td>Code</td>
<td>Eventpoints</td>
<td>Ctrl + E</td>
<td><img src="image" alt="Eventpoints" /></td>
<td>Opens the [Event] window.</td>
</tr>
<tr>
<td></td>
<td>Trace</td>
<td>Ctrl + T</td>
<td><img src="image" alt="Trace" /></td>
<td>Opens the [Trace] window.</td>
</tr>
<tr>
<td></td>
<td>Stack Trace</td>
<td>Ctrl + K</td>
<td><img src="image" alt="Stack Trace" /></td>
<td>Opens the [Stack Trace] window.</td>
</tr>
<tr>
<td>Graphic</td>
<td>Image…</td>
<td>Shift + Ctrl + G</td>
<td><img src="image" alt="Image" /></td>
<td>Opens the [Image] window.</td>
</tr>
<tr>
<td></td>
<td>Waveform…</td>
<td>Shift + Ctrl + V</td>
<td><img src="image" alt="Waveform" /></td>
<td>Opens the [Waveform] window.</td>
</tr>
</tbody>
</table>
## Table B.1  Window Functions (cont)

<table>
<thead>
<tr>
<th>Menu</th>
<th>Option</th>
<th>Shortcut</th>
<th>Toolbar Button</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setup</td>
<td>Radix</td>
<td><strong>Hexadecimal</strong></td>
<td><img src="image" alt="16" /></td>
<td>Uses a hexadecimal for displaying a radix in which the numerical values will be displayed and entered by default.</td>
</tr>
<tr>
<td></td>
<td>Decimal</td>
<td><strong>10</strong></td>
<td></td>
<td>Uses a decimal for displaying a radix in which the numerical values will be displayed and entered by default.</td>
</tr>
<tr>
<td></td>
<td>Octal</td>
<td><strong>3</strong></td>
<td></td>
<td>Uses an octal for displaying a radix in which the numerical values will be displayed and entered by default.</td>
</tr>
<tr>
<td></td>
<td>Binary</td>
<td><strong>2</strong></td>
<td></td>
<td>Uses a binary for displaying a radix in which the numerical values will be displayed and entered by default.</td>
</tr>
<tr>
<td>Emulator</td>
<td>System…</td>
<td></td>
<td><strong>↑</strong></td>
<td>Opens the [Configuration Properties] dialog box allowing the user to modify the debugging platform settings.</td>
</tr>
<tr>
<td>Emulator Settings</td>
<td></td>
<td></td>
<td></td>
<td>Opens the [Emulator Setting] dialog box.</td>
</tr>
<tr>
<td>Start/Stop</td>
<td>Function Setting…</td>
<td></td>
<td></td>
<td>Opens the [Start/Stop Function Setting] dialog box.</td>
</tr>
<tr>
<td>Debug</td>
<td>Debug Sessions…</td>
<td></td>
<td></td>
<td>Opens the [Debug Sessions] dialog box to list, add, or remove the debug session.</td>
</tr>
<tr>
<td></td>
<td>Debug Settings…</td>
<td></td>
<td></td>
<td>Opens the [Debug Settings] dialog box to set the debugging conditions or download modules.</td>
</tr>
<tr>
<td></td>
<td>Reset CPU</td>
<td></td>
<td><img src="image" alt="↑" /></td>
<td>Resets the target hardware and sets the PC to the reset vector address.</td>
</tr>
<tr>
<td></td>
<td>Go</td>
<td>F5</td>
<td><img src="image" alt="F5" /></td>
<td>Starts executing the user program at the current PC.</td>
</tr>
<tr>
<td></td>
<td>Reset Go</td>
<td>Shift + F5</td>
<td><img src="image" alt="Shift + F5" /></td>
<td>Resets the target microcomputer and executes the user program from the reset vector address.</td>
</tr>
<tr>
<td></td>
<td>Go To Cursor</td>
<td></td>
<td><img src="image" alt="Go To Cursor" /></td>
<td>Starts executing the user program at the current PC until the PC reaches the address indicated by the current text cursor position.</td>
</tr>
<tr>
<td></td>
<td>Set PC To Cursor</td>
<td><img src="image" alt="PC" /></td>
<td><img src="image" alt="PC" /></td>
<td>Sets the PC to the address at the row of the text cursor.</td>
</tr>
<tr>
<td></td>
<td>Run…</td>
<td></td>
<td><img src="image" alt="Run…" /></td>
<td>Launches the [Run Program] dialog box allowing the user to enter the PC or PC breakpoint during executing the user program.</td>
</tr>
<tr>
<td></td>
<td>Display PC</td>
<td>Shift + Ctrl + Y</td>
<td><img src="image" alt="Shift + Ctrl + Y" /></td>
<td>Displays the current PC value.</td>
</tr>
<tr>
<td></td>
<td>Step In</td>
<td>F11</td>
<td><img src="image" alt="F11" /></td>
<td>Executes a block of user program before breaking.</td>
</tr>
</tbody>
</table>
### Table B.1 Window Functions (cont)

<table>
<thead>
<tr>
<th>Menu</th>
<th>Option</th>
<th>Shortcut</th>
<th>Toolbar Button</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Debug (cont)</td>
<td>Step Over</td>
<td>F10</td>
<td></td>
<td>Executes a block of user program before breaking. If a subroutine call is reached, then the subroutine will not be entered.</td>
</tr>
<tr>
<td></td>
<td>Step Out</td>
<td>Shift + F11</td>
<td></td>
<td>Executes the user program to reach the end of the current function.</td>
</tr>
<tr>
<td></td>
<td>Step…</td>
<td></td>
<td></td>
<td>Launches the [Step Program] dialog box allowing the user to modify the settings for stepping.</td>
</tr>
<tr>
<td></td>
<td>Step Mode</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Auto</td>
<td></td>
<td></td>
<td>Steps only one source line when the [Source] window is active. When the [Disassembly] window is active, stepping is executed in a unit of assembly instructions.</td>
</tr>
<tr>
<td></td>
<td>Assembly</td>
<td></td>
<td></td>
<td>EXECUTES stepping in a unit of assembly instructions.</td>
</tr>
<tr>
<td></td>
<td>Source</td>
<td></td>
<td></td>
<td>Steps only one source line.</td>
</tr>
<tr>
<td></td>
<td>Halt Program</td>
<td>Esc</td>
<td></td>
<td>Stops the execution of the user program.</td>
</tr>
<tr>
<td></td>
<td>Initialize</td>
<td></td>
<td></td>
<td>Disconnects the debugging platform and connects it again.</td>
</tr>
<tr>
<td></td>
<td>Connect</td>
<td></td>
<td></td>
<td>Connects the debugging platform.</td>
</tr>
<tr>
<td></td>
<td>Disconnect</td>
<td></td>
<td></td>
<td>Disconnects the debugging platform. This option cannot be used in some products.</td>
</tr>
<tr>
<td></td>
<td>Save Memory…</td>
<td></td>
<td></td>
<td>Saves the specified memory area data to a file.</td>
</tr>
<tr>
<td></td>
<td>Verify Memory…</td>
<td></td>
<td></td>
<td>Verifies file contents against memory contents.</td>
</tr>
<tr>
<td></td>
<td>Download Modules</td>
<td></td>
<td></td>
<td>Downloads the object program.</td>
</tr>
<tr>
<td></td>
<td>Unload Modules</td>
<td></td>
<td></td>
<td>Unloads the object program.</td>
</tr>
</tbody>
</table>
9. Appendix C: Command-Line Functions

The emulator supports the commands that can be used in the command-line window.

For details, refer to the online help.
10. Appendix D: Notes on High-performance Embedded Workshop

1. Note on Moving Source File Position after Creating Load Module
   When the source file is moved after creating the load module, the [Open] dialog box may be displayed to specify the source file during the debugging of the created load module. Select the corresponding source file and click the [Open] button.

2. Source-Level Execution
   — Source file
     Do not display source files that do not correspond to the load module in the program window. For a file having the same name as the source file that corresponds to the load module, only its addresses are displayed in the program window. The file cannot be operated in the program window.
   — Step
     Even standard C libraries are executed. To return to a higher-level function, enter Step Out. In a for statement or a while statement, executing a single step does not move execution to the next line. To move to the next line, execute two steps.

3. Operation During Accessing Files
   Do not perform other operations during downloading the load module or saving in the [Verify Memory], [Save Memory], or [Trace] window because this will not allow correct file accessing to be performed.

4. Watch
   — Local variables at optimization
     Depending on the generated object code, local variables in a C source file that is compiled with the optimization option enabled will not be displayed correctly. Check the generated object code by displaying the [Disassembly] window.
     If the allocation area of the specified local variable does not exist, displays as follows.
     
     **Example:**
     The variable name is asc.
     
     asc = ? - target error 2010 (xxxx)

   — Variable name specification
     When a name other than a variable name, such as a symbol name or function name, is specified, no data is displayed.
     
     **Example:**
     The function name is main.
     
     main =
     
     A variable that is allocated to register cannot be selected for monitoring.

   — Variable updating
     For updating of the content of the variable that has been registered in the [Watch] window, read the data after the break in user program execution. The realtime operation for the user program is disabled because the user program is temporarily stopped.

5. Line Assembly
   — Input radix
     Regardless of the Radix setting, the default for line assembly input is decimal. Specify H’ or 0x for the H8 series microcomputers and xxxxh for the R8C, 740, M32C and M16C series microcomputers as the radix for a hexadecimal input.
6. Command Line Interface
   — Batch file
   To display the message “Not currently available” while executing a batch file, enter the sleep command. Adjust the
   sleep time length which differs according to the operating environment.
   
   Example: To display “Not currently available” during memory_fill execution:
   
   sleep d’3000
   memory_fill 0 ffff 0

   — File specification by commands
   The current directory may be altered by file specifications in commands. It is recommended to use absolute paths to
   specify the files in a command file so that the current directory alteration is not affected.
   
   Example: FILE_LOAD C:\Hew3\Tools\Renesas\DebugComp\Platform\E8a\E8aR8C\TutorialR8C\Tutorial\Debug_R8C_E8a_SYSTEM\Tutorial.x30

7. Memory Save During User Program Execution
   Do not execute memory save or verifying during user program execution.

8. Load of Motorola S-type Files
   This High-performance Embedded Workshop does not support Motorola S-type files with only the CR code (H'0D) at
   the end of each record. Load Motorola S-type files with the CR and LF codes (H'0D0A) at the end of each record.

9. [I/O] Window
   — Display and modification
   Do not change values in the [I/O] window because the E8a emulator uses the address break controller.
   
   — Note that the E8a emulator does not support the display of the invalid module in the [I/O] window.
   
   — For the H8/Tiny and H8/Super Low Power series, the E8a emulator does not support the display of the bit
     information in the [I/O] window.

10. Note on [Register] Window Operation During Program Execution
    The register value cannot be changed in the [Register] window during program execution. Even if the changed value is
    displayed, the register contents are not changed actually.

11. Using Register Contents
    Use the value contained in a CPU register by specifying the register name prefixed by the “#” character, e.g.: #R1,
    #PC, #R6L, or #ER3 when you are entering a value elsewhere in the High-performance Embedded Workshop, for
    example when displaying a specified address in the [Disassembly] or [Memory] window.
    In R8C Family, specify and enter the bank number before a register name; e.g., #0R0 or #0R0H.

12. Break Functions
    When the PC breakpoint is set in the flash memory area, the program is written to the flash memory each time the user
    program is executed. At this time, note that the number of rewritable times will be decreased.
    
    — BREAKPOINT cancellation
    When the contents of the BREAKPOINT address are modified during user program execution, the following
    message is displayed when the user program stops.
    
    BREAKPOINT IS DELETED A=xxxxxxxx
    
    If the above message is displayed, cancel all BREAKPOINT settings with the [Delete All] or [Disable] button in
    the [Breakpoints] window.

13. Number of BREAKPOINT and [Stop At] Settings in the [Run...] Menu
    The maximum number of BREAKPOINTs and [Stop At] settings allowed in the [Run...] menu is 255. Therefore, when
    255 BREAKPOINTs are set, specification by [Stop At] in the [Run...] menu becomes invalid. Use the BREAKPOINTs
    and [Stop At] in the [Run...] menu with 255 or less total settings.
14. Note on RUN-TIME Display
   The execution time of the user program displayed in the [Status] window is not a correct value since the timer in the host computer has been used.

15. Note on Displaying Timeout error
   If Timeout error is displayed, the emulator cannot communicate with the target microcomputer. Turn off the emulator and the user system and connect the emulator again by using the High-performance Embedded Workshop.

16. Support of Double Float Format
   In the following memory operations, the double float format is not supported:
   — [Fill Memory] dialog box
   — [Search Memory] dialog box
   — MEMORY_FILL command
     The [Format] specification in the [Copy Memory] dialog box is ignored. Memory is copied in a byte unit.

17. Note on Using the [Run Program] Dialog Box
   When [Run...] is selected from the [Debug] menu to specify the stop address, there is the following note:
   When the breakpoint that has been set as Disable is specified as the stop address, note that the breakpoint becomes Enable when the user program stops.

18. [Stack Trace] window
   When using the NC30WA or NC8C, if parameters and local variables of a function are referred in the call stack window and one or more parameters are on a register, the register parameters may be interchanged with the local variables. However, the correct values are displayed.
   For NC308WA, NC30WA, or NC8C, specify the compiler option ‘-genter’, which is used to output the ENTER or EXITD instruction, to all functions. If this option is not specified, the [Stack Trace] window will not be correctly displayed.

19. Memory Access during User Program Execution
   When a memory is accessed from the memory window, etc. during user program execution, the user program is resumed after it has stopped in the E8a emulator to access the memory. Therefore, realtime emulation cannot be performed.

20. Internal Flash Memory
   The emulator is also available as the programming tool for mass production.
   However, the actual MCU, which has been used by connecting to the emulator, has been programmed to the flash memory at emulation and stressed. Do not use the MCU that has been used for debugging for the mass products.

21. Suspend during Emulator Use
   The host computer cannot enter suspend mode while the emulator is in use.

22. Verification of Memory
   Use the FILE_VERIFY command to verify memory. Do not use [Verify Memory...] in the [Debug] menu.

23. Overwrite of a File
   In command line interface, a file that has the same name as the output file is overwritten without asking the user.

24. Usage with Other Products
   To install the SuperH™ RISC engine C/C++ compiler package or H8, H8/300 series C/C++ compiler package after installing the emulator debugger for the High-performance Embedded Workshop, select [High-performance Embedded Workshop] as the component to be installed in [Select Components] during installation of the compiler package.
25. Download of Load Modules
   When load modules are downloaded, select [Debug] -> [Download] -> [All Download modules].

   When microcomputers are continuously programmed, be sure to turn the target on or off.

   Memory cannot be accessed in the [Program Flash] mode. In this mode, values displayed in the [Memory] or [IO] window are dummy.

28. Memory Access during Flash Memory Programming
   During flash memory programming (e.g., user program execution), operation for memory accessing such as opening the [Memory] window is not allowed. Values displayed here are dummy. Access the memory again after flash memory programming has been completed.
11. Appendix E: E8aSCP (E8a Self-Check Program)

This appendix describes the troubleshooting procedure that applies the self-check program for the E8a emulator (E8aSCP).

11.1 Flowchart of the Procedure to Execute the Self-Check Program

1. Install the High-performance Embedded Workshop. (for the first time)
2. Connect the user system interface cable.
3. Connect the USB cable.
4. Start up the E8aSCP program.
5. Execute the TEST1 program.
6. Disconnect the user system interface cable from the self-check connector.
7. Execute the TEST2 program.
8. The result of self-checking is displayed.
9. Install the E8aSCP program and the USB driver for the E8a to the host computer.
10. Connect the user system interface cable. At this point, do NOT connect the USB cable to the E8a.
11. Connect the USB cable to the USB connector of the host computer and the E8a emulator.
12. Start up the E8aSCP program.
13. Execute the TEST1 program.
14. Disconnect the user system interface cable from the self-check connector.
15. Execute the TEST2 program.
16. The message ‘PASS’ or ‘FAIL’ will be displayed. ‘PASS’: the emulator is working correctly. ‘FAIL’: the emulator has failed. If ‘FAIL’ is displayed, see Table E.1.
11.2 System Setup to Execute the E8aSCP

(1) The following equipment is required to execute the check program.

- E8a emulator main unit
- USB cable included with the E8a emulator
- User system interface cable included with the E8a emulator
- CD included with the E8a emulator
- Host computer
  Install the High-performance Embedded Workshop and the USB driver on the host computer in advance.

(2) Open the cover of the self-check connector for the emulator. Connect the user system interface cable to the user-system connector and the self-check connector.

![Connecting the User System Interface Cable when Using the E8aSCP](image1)

![Connecting the User System Interface Cable to the Self-Check Connector](image2)

- Insert the user system interface cable into the self-check connector with the faulty-insertion-prevention nose below.
## WARNING

### Warnings for Connecting to the Self-Check Connector:

- Make sure to disconnect the USB cable from the E8a before connecting the user system interface cable to the user-system connector or the self-check connector of the E8a. If the E8aSCP program is executed when the USB cable remains connected to the E8a after 'Disconnect' is done from the High-performance Embedded Workshop or Flash Development Toolkit, self-checking will not be executed correctly. This is caused by the different condition of the E8a pins. The E8aSCP program expects that the E8a pins are in the condition right after starting-up the E8a, but after 'Disconnect' is done, they remain in the condition where the E8a is connected to the user system.
- Fully insert the user system interface cable in the self-check connector as shown in Figure E.2.

(3) Start up the host computer, and connect the E8a emulator to the USB connector of the host computer via the USB cable provided.
11.3 Executing the Self-Check Program

(1) Execute [Program]-[Renesas]-[High-performance Embedded Workshop]-[E8a Self Check Program].

![Figure E.3 Starting Up the E8aSCP](image)

(2) Click the ‘START’ button. The following message will be displayed:

‘Please confirm that the User interface cable is connected to the self-check connector in a correct direction’.

Confirm that the user system interface cable is connected to the self-check connector in the correct direction, as shown in Figure E.2, and click the [OK] button. The self-check program will start.

![Figure E.4 Confirming Connection of the User System Interface Cable](image)
(3) The message ‘TEST1 is running.’ or ‘TEST2 is running.’ will appear in the window. This indicates the start of the self-check program.

![Figure E.5 Running the Self-Check Program](image)

(4) When ‘TEST3 is waiting.’ starts, the following message will be displayed:

‘Please remove the User interface cable from the self-check connector to execute TEST3.’

When the above message is displayed, remove the user system interface cable from the self-check connector and close the cover of this connector. Click the [OK] button. The self-check program will be continuously executed.

![Figure E.6 ‘Please remove the User interface cable from the self-check connector to execute TEST3.’ Message](image)
(5) The message ‘TEST3 is running.’ will appear in the window. This starts execution of the self-check program.

![Figure E.7  Running the Self-Check Program](image)

(6) The message ‘PASS’ or ‘FAIL’ will be displayed. ‘PASS’ indicates that the emulator is working correctly. Click the [QUIT] button to exit the self-check program.

![Figure E.8  Quitting the Self-Check Program](image)

If ‘FAIL’ is displayed during execution of the self-check program, the content of an error is displayed at the center of the window. Table E.1 shows error messages.

![Figure E.9  Window Showing an Error](image)

Clicking the [LOG] button opens the dialog box for selecting a file. Specify the destination to save the result of program execution. The result will be saved as a text file.
### Table E.1  Error Messages

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>The E8a has failed.</td>
<td>The E8a emulator has become faulty. If this applies to the contents guaranteed in 'IMPORTANT' described in this user's manual, we will repair or replace your faulty product free of charge. If this guarantee does not apply to your product's fault, we will repair the product or replace it with a new one with extra-charge. However, replacement will be lower in cost and we recommend that you purchase a new emulator.</td>
</tr>
<tr>
<td>Please connect the User interface cable with the self-check connector in a correct direction.</td>
<td>Connect the user system interface cable to the self-check connector in the correct direction, as shown in Figure E.2, before running the self-check program.</td>
</tr>
<tr>
<td>Because the User interface cable was connected with to self-check connector, TEST3 was interrupted. Perform the self-check again from the beginning.</td>
<td>Execution of TEST3 was halted because the user system interface cable was not removed from the self-check connector before starting 'TEST3 is running.' Connect the user system interface cable to the self-check connector in the correct direction, as shown in Figure E.2, and restart the self-check program from the beginning.</td>
</tr>
<tr>
<td>An error occurred during USB I/O processing.</td>
<td>The USB cable was disconnected during execution of the self-check program, or the E8a emulator became faulty. Execute the self-check program again. If this error message is displayed again, the emulator could be faulty.</td>
</tr>
</tbody>
</table>
## Revision History

<table>
<thead>
<tr>
<th>Rev.</th>
<th>Date</th>
<th>Page</th>
<th>Summary</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.03</td>
<td>Mar 15, 2016</td>
<td>21</td>
<td>Regulatory Compliance Notices changed</td>
</tr>
</tbody>
</table>
E8a Emulator (R0E00008AKCE00)
User's Manual